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About this Guide
This guide explains how to upgrade Apama, webMethods, Terracoa when used with
webMethods products, and Universal Messaging.

Document Conventions
Convention

Description

Bold

Identiﬁes elements on a screen.

Narrowfont

Identiﬁes storage locations for services on webMethods
Integration Server, using the convention folder.subfolder:service .

UPPERCASE

Identiﬁes keyboard keys. Keys you must press simultaneously
are joined with a plus sign (+).

Italic

Identiﬁes variables for which you must supply values speciﬁc to
your own situation or environment. Identiﬁes new terms the ﬁrst
time they occur in the text.

Monospace
font

Identiﬁes text you must type or messages displayed by the
system.

{}

Indicates a set of choices from which you must choose one. Type
only the information inside the curly braces. Do not type the { }
symbols.

|

Separates two mutually exclusive choices in a syntax line. Type
one of these choices. Do not type the | symbol.

[]

Indicates one or more options. Type only the information inside
the square brackets. Do not type the [ ] symbols.

...

Indicates that you can type multiple options of the same type.
Type only the information. Do not type the ellipsis (...).
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Online Information
Software AG Documentation Website
You can ﬁnd documentation on the Software AG Documentation website at hp://
documentation.softwareag.com. The site requires Empower credentials. If you do not
have Empower credentials, you must use the TECHcommunity website.
Software AG Empower Product Support Website
You can ﬁnd product information on the Software AG Empower Product Support
website at hps://empower.softwareag.com.
To submit feature/enhancement requests, get information about product availability,
and download products, go to Products.
To get information about ﬁxes and to read early warnings, technical papers, and
knowledge base articles, go to the Knowledge Center.
Software AG TECHcommunity
You can ﬁnd documentation and other technical information on the Software AG
TECHcommunity website at hp://techcommunity.softwareag.com. You can:
Access product documentation, if you have TECHcommunity credentials. If you do
not, you will need to register and specify "Documentation" as an area of interest.
Access articles, code samples, demos, and tutorials.
Use the online discussion forums, moderated by Software AG professionals, to
ask questions, discuss best practices, and learn how other customers are using
Software AG technology.
Link to external websites that discuss open standards and web technology.
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Upgrades Covered in This Guide
This guide explains how to upgrade Apama, webMethods, Terracoa when used with
webMethods products, and Universal Messaging from 9.5 and later to release 10.1 using
a side-by-side procedure.
You can also use the procedures in this guide to migrate data from one 10.1 installation
to another 10.1 installation (for example, for a data center move).
You can use Command Central to upgrade some products and migrate their
conﬁgurations, data, and assets on some upgrade paths (see Software AG Command
Central Feature Support Matrix). Command Central supports these migration scenarios:
Same installation directory, hosts, and ports; live databases. This approach is similar
to over-installation; Command Central renames the old installation directory before
migrating and then uses the old directory name for the new installation.
New installation directory, same hosts and ports, live or cloned databases.
New installation directory and ports, same hosts, cloned databases.
New hosts, live or cloned databases.
You can use Command Central to perform upgrades and migrations step by step, or in a
fully automated way using composite templates. For complete information about using
Command Central, see Software AG Command Central Help.

Support Across Operating Systems
Integration Server, Microservices Container, OneData, and Universal Messaging support
migration across machines that have the same operating system and across machines
that have diﬀerent operating systems.
The other products support migration from a Windows system to another Windows
system, and from a UNIX system to another UNIX system when both systems are
using a JVM from the same vendor. These products do not support migration from one
operating system to a diﬀerent operating system (for example, from a Windows system
to a UNIX system, or vice versa).

Release Numbering Exceptions
The products below did not follow general release numbering.
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Product

Release Numbering

ActiveTransfer

In the webMethods 9.9, 9.10, and 9.12 releases, ActiveTransfer
remained at its 9.8 release.

webMethods
Broker

In the webMethods 9.7 and later releases, webMethods Broker
remained at its 9.6 release.

Presto (now
MashZone
NextGen)

In the webMethods 9.6, 9.7, and 9.8 releases, the Presto release
numbers were 3.7, 3.8, and 3.9, respectively. The Presto release
before Presto became part of webMethods was 3.6.

Terracoa

In the webMethods 9.5, 9.6, 9.7, 9.8, 9.9, 9.10, 9.12, 10.0, and 10.1
releases, the Terracoa release numbers were 3.7.6, 3.7.6, 4.1.4,
4.3, 4.3.1, 4.3.2, 4.3.3, 4.3.4, and 4.3.4, respectively.

Documentation Needed to Perform the Upgrade
You will need the documentation listed below to perform the upgrade.
Release notes for the old release + 1 through the new release; these list new features
Product readmes for the new release; these describe changes to product behavior;
deprecations, removals, and additions of services, APIs, and other items; critical
information about the new product release; and known and resolved issues
Fix readmes for ﬁxes you install on new products; these list resolved issues and
changes in behavior
System Requirements for Software AG Products
Supported Upgrade Paths for Software AG Products
Using the Software AG Installer
Installing Software AG Products
Using the Software AG Update Manager (latest release)
You might need the documentation listed below to perform this upgrade, depending on
the products you are upgrading. The release of the documentation you need is the new
release.
Managing File Transfers with webMethods ActiveTransfer
webMethods API Portal Customization Guide
webMethods Application Platform User’s Guide
Administering webMethods Broker
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webMethods BPM Task Development Help
CentraSite documentation
webMethods Deployer User’s Guide
webMethods Integration Server Administrator’s Guide, webMethods Service Development
Help, and webMethods Integration Server Clustering Guide
MashZone NextGen Administration Guide and MashZone NextGen User and Developer
Guide
Administering My webMethods Server
Administering webMethods OneData
Administering webMethods Optimize and Conﬁguring BAM
Using Terracoa with webMethods Products and Terracoa BigMemory Max
documentation
webMethods Universal Messaging Clustering Guide

Upgrades Not Covered in This Guide
The upgrades listed below are not covered in this guide. Instead, see the indicated
information source.
Upgrade

Information

From a release prior to 9.5

See Supported Upgrade Paths

Apama releases prior to 9.9

See the Apama release notes for the pre-9.9
release

ApplinX

See ApplinX documentation

webMethods Broker to Universal
Messaging

See Migrating from webMethods Broker to
webMethods Universal Messaging

Command Central

See Software AG Command Central Help

Content Service Platform

Contact Software AG Global Consulting
Services

ARIS PPM

See ARIS PPM documentation Migration
9.x and 10.0 to 10.1
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Upgrade

Information

Mobile Administrator on a virtual
machine (this guide explains how
to upgrade Mobile Administrator
on a physical machine)

Uninstall Mobile Administrator from
the virtual machine (see the installation
guide for the old release) and install the
new Mobile Administrator (see Installing
Software AG Products for the new release)

Presto (now MashZone NextGen)
releases prior to 3.6

Contact Software AG Global Consulting
Services

Terracoa when not used with
webMethods products

See Terracoa BigMemory Max
documentation

From Terracoa BigMemory Max
to Terracoa DB

Terracoa DB 10.1 is signiﬁcantly diﬀerent
from Terracoa BigMemory Max 4.x
and 3.7.6 in terms of handling of cluster
topology, data storage formats, and other
functionality. You cannot migrate data and
conﬁguration for a Terracoa BigMemory
Max server to a Terracoa DB server. If
you install Terracoa DB on the same
machines that host Terracoa BigMemory
Max, however, you can ﬁnd the host
names, addresses, and so on that you
used for the Terracoa BigMemory Max
installation in the server conﬁguration
ﬁles.
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Preparation and Planning
Software AG strongly recommends that you plan and prepare for your upgrade before
performing the procedure described in this guide. Planning and preparing can include
the tasks listed below.
Read this guide in its entirety so you are familiar with all tasks you will need to
perform.
Read the product release notes. The release notes provide information on new
functionality. Read the information for every release for your old release + 1 through
the new release.
Read the product readmes for the new release, including the readme for the Software
AG Infrastructure. All readmes are available on the Software AG Documentation
website. The product readmes contain this information:
Critical information and known and resolved issues for your products.
Changes to product behavior, services, parameters, properties, and APIs. Such
changes can include additions, changes, deprecations, and removals. This
information is especially important because you might need to modify product
ﬁles or assets after migration to accommodate the changes.
Read the information in product readmes for your old release+1 through the new
release. For example, if you are upgrading from 9.5 to 10.1, read the information for
releases 9.6 through 10.1.
Deﬁne an upgrade approach and a cut-over plan. If you have a large landscape, you
might want to do a phased upgrade.
Set up operating guidelines that cover normal project management requirements
across all aﬀected groups in your organization.
Deﬁne an approach to source control, and set up release management tools and
procedures that support the migration of data into target environments.
Account for externals to your Software AG environment, such as clients that
communicate with your and Software AG products and that might need endpoint
URL, host name, or IP address updates.
As part of upgrading, you will take a baseline of the old environment and use that
baseline to perform the upgrade procedure. Software AG recommends a code freeze
while you are migrating the baseline to the new environment.
Many upgrade issues are caused by forgoen environmental seings. Plan,
document, and test these thoroughly.
For complex projects that require extensive system testing, extended code freeze
might not be possible. In this case, deﬁne a change management strategy to track
code changes that occur in the old environment. After testing is complete on the
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baseline, this will enable you to merge the code changes into the baseline and re-test
the new baseline.
If you need help creating your planning approach, contact Software AG Global
Consulting Services. You can also go to the Software AG TECHcommunity and ﬁnd tips
and tricks and other information in the upgrade wiki (Wiki > webMethods > Upgrade).

Testing and Troubleshooting
Testing can include the tasks listed below.
Software AG strongly recommends that you upgrade in a controlled test
environment and test that environment for proper operation before promoting to
your production environment.
Provision new environments to support the upgrade. Environments in which you
conduct testing should mirror the production environment.
Obtain test data from the source environment and establish baseline test results.
Many upgrade issues are caused by forgoen environmental seings. Plan,
document, and test these thoroughly.
Identify test tools for unit, functional, and non-functional regression testing.
Deﬁne acceptance and sign oﬀ criteria.
Automate a core set of regression tests for the upgrade. Software AG recommends
focusing your tests most heavily on product areas that have undergone the most
change. The readmes and release notes provide all product change information (see
"Preparation and Planning" on page 18 for details).
If upgrading to new machines, make sure connections and ﬁrewalls are open to
back-end systems before starting any system testing.
Use an issue management system to track defects and issues.
If code freeze of the old environment during test is not possible, merge code changes
from the old environment into the baseline and re-test the new baseline.
If you need help creating your testing approach, contact Software AG Global Consulting
Services.
If you encounter errors during the upgrade, try the troubleshooting methods below.
Look in log ﬁles.
Type of Log

Location

Installation and
uninstallation

new_Software AG_directory /install/logs directory
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Type of Log

Location

Product

In a logs directory in the product ﬁle structure, or in the
new_Software AG_directory /proﬁles/product /logs directory.

Data migration

new_Software AG_directory /install/logs directory and product
directories indicated by the upgrade procedures

Database
migration

new_Software AG_directory /common/db/logs directory.

Go to the Knowledge Center on the Empower Product Support Website and search
using keywords such as upgrade.
Go to the Software AG TECHcommunity and:
Join the upgrade discussion forum (Forums > webMethods > Upgrade).
Read and share tips and tricks and other information in the upgrade wiki (Wiki >
webMethods > Upgrade).
If you cannot resolve the problem using the methods above, contact Software AG Global
Support.

General Upgrade Procedure Requirements
Important: If you do not conform to these requirements, you will experience
unpredictable results, possibly including corruption of your installation and
data.
Perform the tasks in this guide in the exact order in which they are presented. The
task order is critical because your products have many inter-dependencies, including
shared infrastructure and event driven architecture. Make sure to complete the tasks
in the following chapters, in order:
This chapter.
Install New Products and Begin Migration.
All chapters for your products.
Migrate Event Infrastructure and Perform Final Upgrade Tasks for All Products.
After you install the new products, you install the latest ﬁxes (see "Shut Down
Software AG Runtime and Disable Windows Services" on page 30). However,
the upgrade procedure might take days or weeks to complete. Continue to check for
and install new ﬁxes regularly during the procedure.
Do not start any new products before the instructions in this guide tell you to do so,
or your database components could become corrupted.
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Perform the tasks in this guide for all upgrade paths unless the guide states that a
particular task is required for certain upgrade paths only.
This guide assumes you are using the same RDBMS in the new environment that
you used in the old environment. If you want to use a diﬀerent RDBMS in the
new environment, there are special requirements that must be met before you can
upgrade your products. Contact Software AG Global Consulting Services for more
information.

API Portal Requirements
You must have these functional privileges to upgrade API Portal:
License, user, and document management
User management conﬁguration
Database administration
Ask your API Portal administrator to log on to the User Management Component at
hp://host :port /umc, go to the user management page, click your user name, and either
add you to the API Administrator group or go to the Functional Privileges tab and
assign the privileges listed above to you.

webMethods Broker Requirements
If you are going to install the new webMethods Broker on a diﬀerent machine than the
old webMethods Broker, use the same host name for the new machine that you used for
the old machine so you will not have to modify your territory/cluster setup, connection
aliases, or Integration Server Messaging seings.
In the webMethods 9.7 and later releases, the webMethods Broker release number is still
9.6 and is the same release that was available with the webMethods 9.6 release. If you
have webMethods Broker 9.6 and it resides on its own machine, you can continue using
it with your new products. Regardless of whether you install a new webMethods Broker
or not, however, you must perform tasks later in this guide for webMethods Broker.

CentraSite Requirements
If you want to install the CentraSite Application Server Tier and CentraSite Registry
Repository on diﬀerent machines, or in the same directory but at diﬀerent times, you
must install the Registry Repository ﬁrst.
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Integration Server or Microservices Container Clustering
Requirements
Note:

Steps for Microservices Container are identical to those for Integration Server.

In Integration Server, a cluster is deﬁned as multiple Integration Server instances
that point to the same ISInternal database component and connect to the same Cache
Manager on a Terracoa Server Array. A cluster can include Integration Server
installations on diﬀerent machines, server instances within an Integration Server
installation, or both.
This section is intended for use with the rest of this guide. You must perform all tasks in
this guide for your products, in the order they are wrien, with the additional tasks or
exceptions noted in this section.
Use the instructions below with the instructions in "Install New Products and Begin
Migration" on page 27.
When you install the new Integration Servers, create a cluster that matches your
old cluster. You can install the new Integration Servers in parallel.
When you install the ﬁxes on the new Integration Servers you can install the ﬁxes
in parallel.
When you shut down the old products, shut down all cluster nodes.
Use the instructions below with the instructions in "Migrate Integration Server,
Microservices Container, and Hosted Wm Packages" on page 63.
After you migrate server instances, make sure the new server instances are
processing client requests.
The tasks in "Migrate Event Infrastructure and Perform Final Upgrade Tasks for All
Products" on page 125 include a task to conﬁgure your products. For instructions
on conﬁguring Integration Server clusters, see the webMethods Integration Server
Clustering Guide.

My webMethods Server Requirements
Environment Variable
In your old release, you might have identiﬁed a default My webMethods Server
installation in the global path of the installation’s host machine using the environment
variable WM_HOME. If you are going to install the new release on the same machine as
the old release, the existence of this variable could cause problems, so you must remove
the environment variable from the global path.
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My webMethods Server Clustering Requirements
In My webMethods Server, a cluster is deﬁned as multiple My webMethods Server
instances that point to the same MywebMethodsServer database component. A cluster
can include My webMethods Server installations on diﬀerent machines, server instances
within a My webMethods Server installation, or both.
This section is intended for use with the rest of this guide. You must perform all tasks in
this guide for your products, in the order they are wrien, with the additional tasks or
exceptions noted in this section.
Use the instructions below with the instructions in "Install New Products and Begin
Migration" on page 27.
Install Universal Messaging.
Note:

Starting in 10.0, My webMethods Server clustering uses Universal
Messaging instead of a JMS database for messaging.

When you install the new My webMethods Servers, create a cluster that matches
your old cluster. You can install the new My webMethods Servers in parallel.
When you install the ﬁxes on the new My webMethods Servers, you can install
the ﬁxes in parallel.
You do not need to perform the instructions for upgrading the Software AG
Infrastructure.
When you shut down the old products, shut down all cluster nodes.
Use the instructions below with the instructions in "Migrate My webMethods Server"
on page 57.
When you run the My webMethods Server migration utility to migrate server
instances from old My webMethods Server installations to new My webMethods
Server installations, you can migrate the instances in parallel.
When you initialize the server instances, you can initialize them in parallel.
The tasks in "Migrate Event Infrastructure and Perform Final Upgrade Tasks for All
Products" on page 125 include a task to conﬁgure your products. For instructions
on conﬁguring My webMethods Server clusters, see Administering My webMethods
Server.

OneData Requirements
1. Go to the old_Software AG_directory /proﬁles/ODE/conﬁguration/
com.softwareag.platform.conﬁg.propsloader directory. Open the
com.softwareag.catalina.connector.hp.pid-port .properties ﬁle and the
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com.softwareag.catalina.connector.hps.pid-port .properties ﬁle and note the port
numbers.
2. Go to the indicated directory and open the ﬁle or ﬁles below.
9.5, 9.6, 9.7, or 9.8 upgrade: Go to the old_Software AG_directory /proﬁles/ODE/
conﬁguration/tomcat/conf directory and open the context.xml ﬁle.
9.9 and higher upgrade: Go to the old_Software AG_directory /proﬁles/ODE/
conﬁguration/com.softwareag.platform.conﬁg.propsloader directory and open
the com.softwareag.catalina.resource.pid-repository_name schema .properties ﬁles,
where repository_name is the repository name you provided during installation
and schema is md, wa, or ra.
Note the database connection preﬁxes at the beginning of the names for the
metadata, work area, and release area schemas. For example, in the metadata
schema name jdbc/dev2md, the connection preﬁx is dev2. Also note any database
parameters such as maxIdle, maxActive, and maxWait that are speciﬁed for the
schemas.
3. Go to the old_Software AG_directory /proﬁles/ODE/bin/onedata/conﬁg directory.
Open the repository.xml ﬁle and note the Repository Id (RepositoryID element) and
Repository Name (Name element).

9.5 or 9.6 Upgrade: Terracotta Requirements
If you are upgrading from Terracoa 3.x, you must obtain a new license ﬁle. Contact
Software AG Global Support.

Universal Messaging Clustering Requirements
In Universal Messaging, a cluster is deﬁned as multiple server instances in Universal
Messaging installations on the same or diﬀerent machines that are conﬁgured for
clustering.
This section is intended for use with the rest of this guide. You must perform all tasks in
this guide for your products, in the order they are wrien, with the additional tasks or
exceptions noted in this section.
1. Use the instructions below with the instructions in "Install New Products and Begin
Migration" on page 27.
When you install the new Universal Messaging servers instances, create a cluster
that matches your old cluster. You can install the new Universal Messaging
server instances in parallel.
When you install the latest ﬁxes on the new Universal Messaging servers
instances, you can install the ﬁxes in parallel.
When you shut down the old products, shut down all cluster nodes.
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2. Use the instructions below with the instructions in "Migrate Universal Messaging "
on page 50.
When you run the Universal Messaging migration utility to migrate server
instances from old Universal Messaging installations to new Universal
Messaging installations, you can migrate the instances in parallel.
3. Clear channels and queues by deleting the data directories from all but one of the
new server instances.
4. If the new cluster nodes are on the same host machines as the old cluster nodes, start
all new cluster nodes.
If the new cluster nodes are on diﬀerent machines than the old cluster nodes, do the
following:
a. Go to the new_Software AG_directory /UniversalMessaging/
server/instance /bin directory for one cluster node and create a ﬁle
named remote_realms_bootstrap.conf. Add a cross-host mapping
property to the ﬁle for every node that is part of the cluster in
the format instance .address=new_host_name_or_IP (for example,
umserver1.address=myUM1.com or umserver2.address=192.168.0.1). Copy the
ﬁle to the same location for all the other nodes.
b. Start all cluster nodes. The remote_realms_bootstrap.conf ﬁle in every
installation will be renamed remote_realms_bootstrap_old.conf. When a source
Universal Messaging server instance is bound to a speciﬁc network interface
(absolute IP address), the interface of the migrated instance address will bind to
0.0.0.0 (all known interfaces on the port).
5. Open Enterprise Manager to make sure the cluster is running correctly.
6. The tasks in "Migrate Event Infrastructure and Perform Final Upgrade Tasks for All
Products" on page 125 include a task to conﬁgure your products. For instructions
on conﬁguring Universal Messaging clusters, webMethods Universal Messaging
Clustering Guide.

Database Requirements, Recommendations, and Preparation
Check your RDBMS against System Requirements for Software AG Products. If the
RDBMS version you are using is not supported by your new products, upgrade to a
supported RDBMS version.
Some products, like Integration Server, Microservices Container, Optimize, Process
Engine, and Trading Networks, oﬀer features to archive or purge data from their
database components. You can reduce the amount of time needed to migrate
database components later in this procedure if you archive and purge them now. For
instructions, see the product documentation.
Make a backup of the product databases; shut down all ActiveTransfer, Integration
Server, Microservices Container, My webMethods Server, OneData, and Optimize
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instances that connect to database components before making the backup. If you are
upgrading My webMethods Server, back up the My webMethods Server installation
directory at the same time you back up the database. If you have problems, you will
need to restore data from both types of backup.
Software AG strongly recommends using cloned databases when testing your
upgrade. You can clone only those database components that you will want to use
in your new environment. Cloning operations are typically done at the level of
the schema (Oracle) or database (SQL Server and DB2) that contains the product
database components, or at the level of the database user that owns all the database
components. Data cloning is usually performed using export and import tools that
are bundled with the database. For cloning procedures, see your database vendor
documentation.
Software AG recommends the following:
Installing Software AG Products describes the basic grants and privileges needed
to work with product database components. Before cloning the databases, give
the database users that will work with the cloned databases the same basic grants
and privileges that were given to the database users that work with the live
databases.
In some cases, one database user grants permissions to a second user (for
example, the process audit database user grants permissions to a second user to
archive process audit data). Before cloning the databases, create the second user
in the new schema or database.
Use a separate database user (Oracle) or database (SQL Server or DB2) to host the
cloned databases.
The new release might require changes to the database components, such as new
tables, columns, keys, or indexes. You will run database migration scripts that
update the existing database schemas so they are compatible with the new product
release. The scripts might modify the existing database components, or might create
parallel database components with the new structure and then insert, select, rename,
and drop the tables, columns, keys, and indexes. These changes might increase the
size of your database.
Database migration may take many hours, depending on the volume of data, and is
often the critical path for upgrade.
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Read and Complete All Previous Chapters
Before performing any task in this chapter, read all chapters that precede this chapter
carefully and complete all tasks that apply to your products in the order in which they
are presented in those chapters.

Install the New Products
Follow the instructions in Using the Software AG Installer and Installing Software AG
Products to install your new products in a new installation directory, with the additional
guidelines in this section.
If you are upgrading a cluster of Integration Servers, Microservices Containers, My
webMethods Servers, or Universal Messaging servers, read the clustering requirements
for those products in "Critical Factors and Requirements for Successful Upgrade" on
page 17 before proceeding.

Hardware Requirements
Installing Software AG Products contains hardware requirements for each product.
However, in some cases you will need additional hard drive space on the target
machine.
If you are upgrading products involving Software AG Designer projects, make sure
the target machine has enough space for the projects you will migrate (see "Migrate
Software AG Designer and Business Process Runtime" on page 79).
If you are upgrading Integration Server or Microservices Container, make sure the
target machine has enough space for custom packages you will migrate. Custom
packages include packages created by users in Software AG Designer and business
process runtime packages generated by users from Software AG Designer.

Run the Software AG Installer
1. For installation directory, specify a new Software AG installation directory.
2. On the product tree, select the products to install. Also select Database
Conﬁguration.
3. For the product panels, follow the instructions in Installing Software AG Products,
with the additional guidelines below.
Note:

If you are installing the new products on the same machine as the old
products, the installer often allows you to assign ports used by an old
product to the new product as well, even if the old product is running.
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Assigning the same ports means you will not need to edit port values in
assets and clients when you begin using the new release.
Product

Guidelines

ActiveTransfer
Server

Point the database connection at the ActiveTransfer database
component you want to use with the new ActiveTransfer
Server.

Apama

If installing the new Apama on the same machine as the
old Apama, specify a new work directory. Software AG
recommends including the release number in the work
directory name, as shown in the default.

webMethods
Broker

Choose to not create a Broker Server conﬁguration.

Integration
Server or
Microservices
Container

Point the database connection at the ISInternal database
component you want to use with the new Integration Server
or Microservices Container.

My
webMethods
Server

Select Side-by-side installation for upgrade. No instance will be
created.

OneData

Enter the values you noted earlier from the old installation
for ports, repository ID, repository name, and database
connection preﬁxes and parameters. Make sure the database
connections point to the OneData database components you
want to use with the new OneData.
Note: Reusing port values means that Web service clients of
the old OneData will not have to change URLs to access
the new OneData.

Trading
Networks

Point the database connection at the TradingNetworks
database component you want to use with the new Trading
Networks.

Universal
Messaging

Select Side-by-side installation for upgrade. No instance will be
created.

Upgrading Software AG Products Version 10.1

29

M

Even Header
Install New Products and Begin Migration

Complete Post-Installation Tasks
Complete Installation of the New Products
Follow the instructions in Installing Software AG Products to complete the installation of
the new products.
For My webMethods Server, if you installed the new release on the same machine as
the old release, you removed the environment variable WM_HOME from the global
path. Do not redeﬁne the environment variable after installing the new My webMethods
Server.

Install Latest Fixes on New Products
The instructions in Installing Software AG Products include installing the latest ﬁxes on
your new products.
Install the latest product ﬁxes on all new products except the infrastructure
components named Common Platform and Security Infrastructure and the database
scripts. You will apply those ﬁxes later in the procedure.
Note:

When you installed My webMethods Server, you did not create an
instance. The ﬁx was therefore copied to the My webMethods Server
installation and gets deployed after you migrate the old server instances
later in this guide, when you initialize My webMethods Server.

For some products, ﬁxes relating to migration are separate from product ﬁxes. Install
the latest migration ﬁxes on all new products, including Common Platform and
Security Infrastructure. Fix names for these products typically include the leers
OSGI and SIN, respectively.
Install the latest migration framework ﬁx. Fix names for the migration framework
follow the convention MIG_release _MigrationFramework_Fixnumber and are listed
under Common Library.
For instructions on installing ﬁxes, see Using the Software AG Update Manager and the ﬁx
readme ﬁles.
Important: If your upgrade procedure take days or weeks to complete, continue to check
for and install new ﬁxes regularly during the procedure.

Shut Down Software AG Runtime and Disable Windows Services
Software AG Runtime starts automatically after installation. Shut down Software AG
Runtime by stopping the Windows service or UNIX daemon. You can use the shutdown.
{bat|sh} scripts in new_Software AG_directory /proﬁles/CTP/bin directory.
If you installed your new products on a Windows system, and you installed them as
Windows services, the default startup mode for the services is Automatic. To prevent
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the new products from starting accidentally before this procedure instructs you to
start them, set the services to Manual. If you installed on a UNIX system, and you have
scripts that automatically start daemons, disable the scripts for the same reason.
Important: Do not start any of the new products at this point. Do not start any of the
new products before the instructions in this guide explicitly tell you to do so,
or your database components could become corrupted.

Prepare the Old Environment for Upgrade
Install Fixes on Old Products
Install the latest product ﬁxes on the old ActiveTransfer, API Gateway, API Portal,
webMethods Broker, CentraSite, Infrastructure Data Collector, MashZone NextGen
Explorer, My webMethods Server, Optimize, and Process Engine. For instructions on
installing ﬁxes, see Using the Software AG Update Manager and the ﬁx readme ﬁles. After
you install the ﬁx on the old product, start the old product.

10.0 Upgrade: Prepare the Old API Gateway
In this section you will do the following:
Back up the Event Data Store.
Create a snapshot of the Event Data Store, and create backups of the conﬁgurations
for the old Integration Server that hosts API Gateway and for one API Gateway
instance. You can migrate only one API Gateway instance.
1. Specify the location in which to store a backup of the data in the old Event
Data Store. Go to the old_Software AG_directory /instances/instance /packages/
WmAPIGateway/cli/bin directory and run the command below. The -path directory
must exist and you must have write permissions to it. By default, -tenantName uses
the API Gateway host Integration Server and the instance name "default."
apigatewayUtil.[bat|sh] configure fs_path
-path full_path_to_dir_for_Event_Data_Store_backup_output
[-tenant API_Gateway_instance ] -debug true

2. Restart the old API Gateway.
3. Open a command window or shell and go to the old_Software AG_directory /
IntegrationServer/instances/instance /packages/WmAPIGateway/cli/bin directory,
where instance is the API Gateway instance you want to migrate. Then run the
command below.
apigw-upgrade-backup.[bat|sh]
-backupDestinationDirectory full_path_to_directory_for_backup_output
[-backupFileName name_for_backup_output ]
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Must exist, must be diﬀerent from the -path
backupDestinationDirectorydirectory from step 1, and you must have

write permissions to it.

[-backupFileName]

Cannot contain spaces or a ﬁle name
extension. Default is apigw-upgradebackup.zip.

The command creates the following in -backupDestinationDirectory:
File named -backupFileName.zip. This ZIP ﬁle contains the backup of host
Integration Server and API Gateway conﬁgurations.
Directory named API Gateway_instance . This directory contains the snapshot of
the Event Data Store, named -backupFileName.
4. If the old and new API Gateway installations are on diﬀerent machines, copy the API
Gateway_instance directory and the ZIP ﬁle to the new machine.

Prepare the Old API Portal
1. Start the old API Portal Cloud Controller.
2. If the old API Portal is installed in a clustered, high-availability setup, make sure
all nodes are running and accessible to the ZooKeeper ensemble. Then register each
node with the parent node by running this command:
acc> add node logical_node_name IP_address_or_host_name [@port ]
user_name password

3. Run this command:
acc> startall

4. Run this command to make sure all API Portal components are running:
acc> list

5. Back up the old master tenant to a ﬁle.
For
9.7

9.8

Run these commands...
acc> set acc config backup.restore.tenant.app.types=com.aris.umcadmin.
y-umcadmin-run-prod
acc> set acc config backup.restore.tenant.app.type.names=umc
acc> backup tenant master to full_path_to_backup_file
username=your_user_name password=your_password
acc> set acc config backup.restore.tenant.app.types=ECP,ADS,UMC
acc> backup tenant master to full_path_to_backup_file
username=your_user_name password=your_password
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For

Run these commands...

9.9
9.10
9.12

acc> set acc config backup.restore.tenant.app.types=ECP,ADS,UMC
acc> backup tenant master to full_path_to_backup_file
username=your_user_name password=your_password

10.0

acc> backup tenant master to full_path_to_backup_file
username=your_user_name password=your_password

6. For each tenant in the old API Portal, you will have to create a tenant in the new API
Portal. List all tenants in the old API Portal by running this command:
acc> list tenants

7. Back up each old tenant’s API and related data; user data; API Portal document
storage data, including all access rights; and collaboration data to a ﬁle. The ﬁle
extension .acb will automatically be added to each ﬁle.
For
9.7

9.8

9.9
9.10
9.12
10.0

Run these commands...
acc> set acc config backup.restore.tenant.app.types = com.aris.umcadmin.
y-umcadmin-run-prod, com.aris.modeling.components.y-server-run-prod,
com.aris.adsadmin.y-adsadmin-run-prod, com.aris.runnables.ecp-run-prod
acc> set acc config backup.restore.tenant.app.type.names = umc, abs,
ads, ecp
acc> backup tenant tenant_name to full_path_to_backup_file
username=your_user_name password=your_password
acc> set acc config backup.restore.tenant.app.types=UMC,ABS,ADS,ECP
acc> backup tenant tenant_name to full_path_to_backup_file
username=your_user_name password=your_password
acc> set acc config backup.restore.tenant.app.types=UMC,ABS,ADS,ECP
acc> backup tenant tenant_name to full_path_to_backup_file
username=your_user_name password=your_password
acc> backup tenant tenant_name to full_path_to_backup_file
username=your_user_name password=your_password

8. If you created a customized view of your old API Portal, back up the view as
follows:
a. Open API Portal in a browser and log on with Administrator credentials.
b. Go to the Administration page. In the Views page under the Customization section,
hover over the name of the custom view and click Backup. API Portal creates a
ZIP ﬁle that contains the customized view.
c. Save the ZIP ﬁle.
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Prepare the Old CentraSite
1. If you changed seings for CentraSite Control from their defaults, note those seings
so you can make the same changes in the new CentraSite installation.
2. If the new and old CentraSites are on the same machine, make sure the old
CentraSite is shut down.
3. Export conﬁguration data from the old CentraSite and assets from the old Registry
Repository into a ZIP ﬁle. On the old machine, open a command window or shell,
go to the old_Software AG_directory /CentraSite/utilities directory, and run the
appropriate command below.
System
Windows
UNIX

Command
sbsExport.cmd full_path_to_ZIP_file
sbsExport.sh full_path_to_ZIP_file

An example of this command for UNIX is as follows:
./sbsExport.sh /tmp/sbs_cs82_data.zip

4. If the old and new CentraSite installations are on diﬀerent machines, copy the ZIP
ﬁle to any directory on the machine that hosts the new CentraSite.

Prepare the Old Software AG Designer
Export Integration Server or Microservices Container Definitions
1. In the old Software AG Designer, go to Window > Preferences. On the Preferences
dialog box, in the left navigation bar, go to Software AG > Integration Servers.
2. Click Export and complete the dialog box. Software AG Designer will save the ﬁle
with the extension .properties.

Export CloudStreams Server Definitions and Projects
1. To export CloudStreams Server deﬁnitions, go to Window > Preferences.
On the Preferences dialog box, in the left navigation bar, go to Software AG
> CloudStreams Servers. Click Export and complete the dialog box. Software AG
Designer will save the ﬁle with the extension .properties.
2. Open the CloudStreams Development perspective. In the CloudStreams Governance
list, right-click CloudStreamsGovernance projects to export, click Export, and complete
the dialog box.
3. Repeat the previous step to export CloudStreams Provider projects.
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Export Preferences
If you want to migrate your preferences to the new Software AG Designer, you export
them from the old Software AG Designer and then import them into the new Software
AG Designer. To export the preferences, do the following:
1. In the old Software AG Designer, open the File > Export wizard. In the Select panel, go
to General > Preferences and click Next.
2. In the To preference file ﬁeld, specify the name of the ﬁle to which you want to export
your preferences. Software AG Designer will save the ﬁle with the extension .epf.

Prepare the Old Integration Server or Microservices Container
Note:

Steps for Microservices Container are identical to those for Integration Server.

Start and Connect Products
1. If you are using webMethods Broker, shut down the new Broker Monitor if it is
running. Restart the old Broker Monitor, and then start the old Broker Server.
2. Start the old Integration Server and open the old Integration Server Administrator.
3. If you are using webMethods Broker, make sure Integration Server is connected
to the Broker. If you are using Universal Messaging, make sure Integration Server
is connected to each Universal Messaging server that is acting as a webMethods
Messaging provider.
4. If you are using another JMS provider, make sure Integration Server is connected to
the JMS provider.

9.5 Upgrade: Suspend Triggers and Make Sure Queues are Drained
1. Quiesce Integration Server. Specify at least 1 minute for the quiesce to occur, so
Integration Server has time to stop executing new incoming requests and to ﬁnish
executing in-ﬂight services. For instructions and details about speciﬁc actions
that occur when Integration Server is quiesced, see webMethods Integration Server
Administrator’s Guide.
2. Go to the Settings > Messaging > webMethods Trigger Management page. If the Current
Queue Counts ﬁeld does not show 0 for every trigger, diagnose and ﬁx the problem
(for example, the JMS provider might not be active or might be slow to process
requests from Integration Server). Refresh the page until the Current Queue Counts
ﬁeld shows 0 for every trigger.
3. Go to the Settings > Resources > Store Settings page. In the Outbound Document Store
area, make sure the Current Documents in Outbound Store ﬁeld shows 0.
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9.6 and Higher Upgrade: Suspend Triggers and Make Sure Queues are Drained
1. Go to Settings > Quiesce page. Click Enter Quiesce mode and set the time for the quiesce
to occur to at least 1 minute, so Integration Server has time to stop executing new
incoming requests and to ﬁnish executing in-ﬂight services. Make sure the Quiesce
Report shows the status SUCCESS in every ﬁeld. For instructions and details about
speciﬁc actions that occur when Integration Server is quiesced, see webMethods
Integration Server Administrator’s Guide.
2. Go to the Settings > Messaging > webMethods Trigger Management page. If the Current
Queue Counts ﬁeld does not show 0 for every trigger, diagnose and ﬁx the problem
(for example, the JMS provider might not be active or might be slow to process
requests from Integration Server). Refresh the page until the Current Queue Counts
ﬁeld shows 0 for every trigger.
3. Go to the Settings > Messaging > webMethods Messaging Settings page. Make sure the
CSQ Count ﬁeld shows 0 for the Broker or Universal Messaging connection alias,
depending on which product you are using.

Make Sure Queues are Drained and Complete or Suspend Business Processes
1. Go to the Settings > Messaging > JMS Settings page. In the JMS Connection Alias
Definitions area, make sure the CSQ Count ﬁeld shows 0 for every JMS connection
alias.
2. If you are going to upgrade business processes, and you have business process
models that use volatile transition documents and process instances of those models
are in a Started state, allow the Started process instances to complete or suspend
them before you upgrade.
Important: If you do not allow Started process instances to complete or suspend
before you upgrade, you could lose data.
Note:

Started process instances of models that use guaranteed transition
documents do not have to complete or be suspended before you upgrade.

Prepare the Old MashZone NextGen
9.10 or 9.12 upgrade: MashZone NextGen 10.0 and later do not support the PPM Chart
View. To remove the view from the MashZone NextGen database, open the MashZone
NextGen Developer or MashZone NextGen Administrator, go to the API Console, and
send this request:
{

"version": "1.1",
"sid": "AppService",
"oid": "removeApp",
"svcVersion": "0.1",
"params": [
"ppm-chart"
]
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}

A response of true indicates that the view has been removed.

9.12 or 10.0 Upgrade: Prepare the Old MashZone NextGen Visual
Analytics
In MashZone NextGen Explorer 10.1, the product's streaming architecture was
completely reworked. Therefore you cannot use real-time data sources from MashZone
NextGen Visual Analytics 9.12 or 10.0, or analyses that depend on real-time data sources
from MashZone NextGen Visual Analytics 9.12 or 10.0, with MashZone NextGen
Explorer 10.1. Remove these data sources and analyses as described below.
1. Start the old MashZone NextGen Visual Analytics, open the Analyses View in Visual
Analytics Explorer, and delete all analyses using real-time data sources.
2. Go to the old_Software AG_directory /MashZoneNG/VisualAnalytics/data/autodeploy/stream directory and undeploy all real-time data sources by deleting the .vsd
data source description ﬁles.
3. In the old MashZone NextGen Visual Analytics, go to the Data Sources View in
Visual Analytics Explorer and make sure the real-time data sources are no longer
listed.
4. In the old_Software AG_directory /MashZoneNG/VisualAnalytics/data/auto-deploy/
stream directory, delete the Apama cache conﬁguration ﬁles.

Prepare the Old My webMethods Server
When you edit conﬁguration seings for My webMethods Server, you download the
appropriate conﬁguration ﬁle from the MywebMethodsServer database component
to the My webMethods Server installation and make the changes in that ﬁle. You then
either upload the ﬁle to the database component and delete it from the ﬁle system, or
keep it in the ﬁle system so its seings are used in preference to the equivalent seings in
the database. Go to the old_Software AG_directory /MWS/server/instance /conﬁg directory
and check for any such ﬁles. If you do not want such ﬁles to be migrated to the new
installation, delete them from the old installation.

Prepare the Old OneData
1. In the old OneData, go to the Home > Administer > Job Center page. On the Filter page,
for each job type, ﬁlter by Active or Pending Active. If a job has one of these statuses,
terminate the job or wait for it to complete.
2. If you are using JMS with OneData, go to the old_Software AG_directory /proﬁles/
ODE/webapp/onedata/WEB-INF/lib directory and back up all client jar ﬁles required
for JMS providers.
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3. If you are using Kerberos authentication with OneData, back up your Kerberosbased SSO conﬁgurations and ﬁles.
Go to old_Software AG_directory /...

Back Up This File

proﬁles/ODE/conﬁguration/tomcat/conf

server.xml

proﬁles/ODE/conﬁguration

custom_wrapper.conf and
jaas.conﬁg

proﬁles/ODE/workspace/webapps/onedata/
WEB-INF

web.xml

proﬁles/ODE/conﬁguration/
com.softwareag.platform.conﬁg.propsloader

All com.softwareag.jaas.
realm.pid-SSO_realm_name

Prepare the Old Optimize
1. If you want to reuse your Central Conﬁgurator System (CCS) Environment
deﬁnition, export the environment to an XML ﬁle. In My webMethods, go to the
Administration > System-Wide > Environments > Define Environments page. Select the check
box next to the environment, click Export, and provide a ﬁle name and location for
the exported environment.
2. If you want to cluster Analytic Engines in the new installation, you will need
a Terracoa Server Array. For planning information, see Using Terracoa with
webMethods Products, Conﬁguring BAM, and the Terracoa BigMemory Max
documentation.

Shut Down the Old Products
For most products, see the instructions in the table below to shut down on a Windows
system. On a UNIX system, use the instructions in the product documentation for your
old release.
Running as...

Shut down from...

Services

Windows Services window. Services are listed as Software AG
product release.

Applications

Windows Start menu. Applications are listed as Software AG >
Stop Servers > product.
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For the products below, follow these instructions.
Product

Shut Down Instructions

API Portal

If the old and new API Portal are on the same machine:
Run this command in the old API Portal Cloud Controller:
acc> stopall

Stop the cloud agent by going to the old_Software AG_directory /
API_Portal/server/bin directory and running this command:
CloudAgentApp.{bat|sh} stop

CentraSite

If the old and new CentraSite are on the same machine,
shut down all old Application Server Tiers by stopping the
Software AG Runtime services, then shut down the old Registry
Repository by stopping its service.

EntireX

Shut down EntireX as instructed in the previous table, then
shut down all Brokers, RPC Servers, and customer applications
that use EntireX libraries. For instructions, see the product
documentation for your old release.

Mobile
Administrator

Run this command:

Terracoa

Shut down all non-webMethods clients.

/etc/init.d/appfresh-mobile stop

Migrate Database Components
The new release might require changes to the database components, such as new tables,
columns, keys, or indexes. In this section, you run database migration scripts that
update the existing database schemas so they are compatible with the new product
release. The scripts might modify the existing database components, or might create
parallel database components with the new structure and then insert, select, rename,
and drop the tables, columns, keys, and indexes. These changes might increase the size
of your database.

Shut Down Products that Connect to Database Components
If you have not already done so, shut down all old ActiveTransfer, Integration Server,
Microservices Container, My webMethods Server, OneData, and Optimize instances that
connect to database components.
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Before You Migrate Trading Networks Database Components
1. If you created custom indexes for your Trading Networks database components,
check whether those custom indexes conﬂict with indexes that will be created when
you run the Trading Networks database migration scripts in the next step. If so, drop
the custom indexes. The database migration scripts are located in the new_Software
AG_directory /common/db/scripts/RDBMS /tradingnetworks/migrate directory, under
the directories listed below.
Old Release

Directories

9.5 or 9.6

/45_to_50

9.7

/50_to_55

9.8

/55_to_56 and 56_to_65

9.9

/65_to_70

Special Considerations for Migrating Other Database Components
If you are using business processes, you have stored information about in-progress,
completed, or failed business process instances. This stored information is called
business process runtime data. If you do not want to ﬁnish running in-progress
process instances or resubmit completed or failed process instances from your old
installation in your new installation, do not migrate your business process runtime
data (see the table in "Migrate Database Components" on page 39).
If you are using Optimize with a DB2 RDBMS, there are special considerations for
the URL you specify on the database component migration command. You must do
the following:
Specify the schema name in the URL using all capital leers.
Specify the options CreateDefaultPackage=true,ReplacePackage=true, and
DynamicSections=3000. These seings will aﬀect all database components in
the same schema or database.

Install Fixes on Database Migration Scripts
Install the latest ﬁx on the database migration scripts. The ﬁx names follow the
convention DC_old_release_number _DBS_Fixlatest_ﬁx_number . For instructions on
installing ﬁxes, see Using the Software AG Update Manager and the ﬁx readme ﬁle.
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Migrate Database Components
Important: After you migrate database components to the new release, you can no
longer use them with your old environment.
On the machine on which you installed the new Database Conﬁguration, open a
command window or shell, go to the new_Software AG_directory /common/db/bin
directory, and migrate database components by running the command below. For values
for product , see the table below.
dbConfigurator.{bat|sh} -a migrate -d {oracle|sqlserver|db2luw} product
-v latest -l db_server_URL -u existing_db_user -p password

After you run each command, check the log ﬁle dcc_yyyymmddhhmmss in the
new_Software AG_directory /common/db/logs directory.
If you are using an Oracle or DB2 RDBMS, and you are not using the default tablespace,
also specify the -tsdata data_tspace_name and -tsindex index_tspace_name
parameters.
On an AIX system, enclose the values “db_server_URL”, ”existing_db_user”, and
“password” in quotation marks.
If you are upgrading...

Values for product ...

Integration Server or
Microservices Container

-pr IS

ActiveTransfer Server
API Gateway
Business process runtime
data and Business Rules
Archive, Staging, or
Reporting database
components
Mediator
My webMethods Server

Note: Migrate the Integration Server or Microservices
Container database components before
migrating other database components.
-c ActiveTransfer
-c APIGatewayEvents
-pr BPM

-c {Archive|Staging|Reporting}

-c MediatorEvents
-pr MWS
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If you are upgrading...
OneData

Values for product ...
-c {OneDataMetadata|OneDataReleaseArea|OneDataWorkArea}

Optimize
Trading Networks

-pr OPTIMIZE
-pr TN

Prepare to Migrate Product Configurations and Data
Migration Utilities
Most products oﬀer migration utilities that automatically migrate conﬁgurations and
data from your old installation to your new installation. This section describes the
general behavior of the migration utilities; any exceptions to the general behavior are
noted in the product-speciﬁc chapters.
Some migration utilities for some products run without prompting you for any
information. Migration utilities for other products ask for the conﬁgurations and data to
migrate, and oﬀer these options:
You can run a custom migration, in which you select the conﬁgurations and data to
migrate. The utility gathers your seings through a series of prompts, then migrates
the selected conﬁgurations and data. You can export your seings to a ﬁle named
migrate.dat and use them in other upgrades.
You can run a migration with imported seings. The imported seings can
come from seings you exported from a custom migration, or from the default
migration provided by Software AG with the product installation in a ﬁle named
migrateold_release sbs.dat. The seings for default migrations are described in the
product-speciﬁc chapters.
Note:

When you run migration utilities, you provide the full path to the old
installation, and sometimes the path to the new installation. If you supplied
a symbolic link as the installation directory when you installed the old or
new product, the path you provide to the migration utility must be the same
symbolic link path you supplied during installation.

If a migration utility fails to migrate an item, the utility asks whether to continue with
the next item or abort the migration. If you choose to abort, the utility exits. The utility
does not revert the new product installation. You can address the issue and rerun the
utility.
Migration utilities write detailed migration information to the command window and
to the migrationLog.txt ﬁle in the new_Software AG_directory /install/logs directory.
By default, utilities write INFO, ERROR, and FATAL messages to the log. If you
want to increase the logging level for a product’s migration to DEBUG, go to the
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product directory that contains the log4j.properties ﬁle (for example, the new_Software
AG_directory /product /bin/migrate or /migrate/bin directory), open the ﬁle in a text
editor, set the log4j.logger.Migration property to DEBUG, MigrationFile, and save
and close the ﬁle.

Create ZIP Files as Source of Old Product Installations to Migrate
If your old and new installations for a product are on diﬀerent machines, create a ZIP
ﬁle of the old product installation to use as the migration source.

Create a ZIP File for My webMethods Server
1. On the old machine, open a command window or shell, go to the old_Software
AG_directory /MWS/bin/migrate or old_Software AG_directory /MWS/bin directory,
depending on which old release you have, and run the command ZIP-mws.{bat|
sh}. The command creates a ZIP ﬁle named mws.zip in old_Software AG_directory /
MWS/migrate-zip directory.
2. Copy the mws.zip ﬁle to any directory on the machine that hosts the new My
webMethods Server.
Important: If using FTP to copy, use the binary ﬁle transfer mode\type. If you use
another mode\type, the ZIP ﬁle might become corrupted.

Create ZIP Files for All Other Products
The instructions below use the Java Archive tool to create the ZIP ﬁle. Specify the
location of the Java Archive tool in the JAVA_HOME and PATH system variables on
the machine that hosts the old product installation. The tool is located in the Software
AG_directory /jvm/jvm/bin directory.
Note:

On some systems, the lower-level jvm directory name includes additional
information, such as /jvm/jvm160_32, or /jvm/jvm170, or /jvm/jvm_64.

1. Go to the product’s old machine and open a command window or shell.
2. Go to the Software AG directory that contains the old product and enter the
command indicated in the table below. If multiple commands are listed, use the
same ZIP ﬁle name in each command.
3. Copy the product’s ZIP ﬁle to any directory on the machine that hosts the new
product.
Important: If using FTP to copy, use the binary ﬁle transfer mode\type. If you use
another mode\type, the ZIP ﬁle might become corrupted.
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Product

Run this command...

Application
Platform

You can reduce the ZIP ﬁle size by ﬁrst moving the log
ﬁles out of the old_Software AG_directory /proﬁles/product /
logs directory, where product is the host Integration Server
instance, the host My webMethods Server instance, or
SPM (for Platform Manager).
jar cfM ZIP_file_name .zip install\products profiles

Digital Event
Services

If your installation includes the ﬁle migrate.{bat|sh}
in the new_Software AG_directory /common/migrate/
DigitalEventServices/bin directory:
jar cfM ZIP_file_name .zip install/products
jar ufM ZIP_file_name .zip common/DigitalEventServices

If the following directories exist, add them to the ZIP ﬁle:
jar ufM ZIP_file_name .zip profiles/product
/configuration/DigitalEventServices

Event
Routing

If your installation includes the ﬁle migrate.{bat|sh} in
the new_Software AG_directory /common/migrate/EDA/bin
directory:
jar cfM ZIP_file_name .zip install/products
jar ufM ZIP_file_name .zip common/conf common/EventTypeStore

If the following directories exist, add them to the ZIP ﬁle:
jar ufM ZIP_file_name profiles/product /configuration
/event/routing optimize/analysis/conf/event/routing

Software AG
Infrastructure
(speciﬁcally,
Software AG
Runtime)

You can reduce the ZIP ﬁle size by ﬁrst moving the log
ﬁles out of the old_Software AG_directory /proﬁles/CTP/logs
directory.
jar cfM ZIP_file_name .zip common/conf install/products
profiles/CTP

You might see the message profiles/CTP: no such
file or directory. You can ignore this message.
Infrastructure
Data
Collector

You can reduce the ZIP ﬁle size by ﬁrst moving the log
ﬁles out of the old_Software AG_directory /proﬁles/InfraDC/
logs directory.
jar cfM ZIP_file_name .zip common/conf install/products
profiles/InfraDC

Integration
Server or
Microservices
Container

9.5 upgrade: You can reduce the ZIP ﬁle size by ﬁrst
moving the log ﬁles out of the old_Software AG_directory /
proﬁles/IS/logs and /IntegrationServer/logs directories.
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Product

Run this command...
9.6 and higher upgrade: You can reduce the size of the
ZIP ﬁle by ﬁrst moving the log ﬁles out of the old_Software
AG_directory /proﬁles/instance /logs, /IntegrationServer/
instances/logs, and /IntegrationServer/instances/instance /
logs directories.
jar cfM ZIP_file_name .zip *

OneData
Universal
Messaging

jar cfM ZIP_file_name .zip install/products
profiles/ODE/bin/onedata/config/*

9.5 or 9.6 upgrade:
jar cfM ZIP_file_name .zip install/products
nirvana/server

9.7 and higher upgrade:
jar cfM ZIP_file_name .zip install/products
UniversalMessaging/server

Migrate the Software AG Infrastructure
Infrastructure components are automatically installed with products. These components
are the Software AG Common Platform, Software AG Runtime, Software AG Security
Infrastructure, and Software AG Web Services Stack.

Before Migrating
Make sure none of the new products are running. If the new and old products are on the
same machine, make sure the old products are shut down.

Run the Software AG Infrastructure Migration Utility
The Software AG Infrastructure utility migrates the following:
Software AG Runtime debug, JAAS, JMX, port, security, single-sign on, watchdog,
and Web Services Stack conﬁgurations.
Journal log seings, user repository, and password store.
Java Service Wrapper customizations you made in the old custom_wrapper.conf
ﬁles, including #include directives and comments (but not associated properties).
Users, groups, and roles.
Proxy conﬁguration ﬁles for proxy types HTTP, HTTPS, FTP, and SOCKS. The utility
migrates ﬁles for proxies that are not already conﬁgured in the new installation.
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Starting in 10.0, Software AG Security Infrastructure no longer supports SSX or SSX
LoginModules. The migration utility migrates LoginContexts that do not contain SSX
LoginModules. However, if an old LoginContext contains SSX LoginModules, the
migration utility does the following:
Use Case

Utility Behavior

LoginContext exists
in old and new
release

Adds comment to new LoginContext that no
migration was performed.

LoginContext exists
in old release but
not in new release

Adds empty LoginContext to new release with
comment that no migration was performed. This is
to prevent software that used the old LoginContext
from failing because of missing context.

Starting in 10.1, the migration utility does not support migration of JKS ﬁles that are not
in the Software AG installation directory.
The Software AG Infrastructure migration utility runs without prompting you for any
information. If an error occurs, the utility exits.
For a general description of migration utility behavior, see "Migration Utilities" on page
42.
1. On the machine that hosts the new products, open a command window or shell, go
to the new_Software AG_directory /common/migrate/osgi/bin directory, and run the
command below. For the migrateold_release sbs.dat ﬁle, specify old_release without
periods (for example, 980, or 9100).
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory|ZIP_file}
-importFile migrateold_release sbs.dat
-silent true

2. If you see a Software AG_directory /proﬁles/CTP directory in both the old and new
installation directories, go to the new_Software AG_directory /proﬁles/CTP/bin/migrate
directory and run the same command again.
3. Install the latest product ﬁx on the new Common Platform and the new Security
Infrastructure. Fix names for these products typically include the leers OSGI and
SIN, respectively. For instructions on installing ﬁxes, see Using the Software AG
Update Manager and the ﬁx readme ﬁles.

Migrate LDAP Server Configuration
Go to the old_Software AG_directory /proﬁles/CTP/
conﬁguration/com.softwareag.platform.conﬁg.propsloader/
com.softwareag.security.ldap.pid.properties directory and copy all
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ﬁles to the new_Software AG_directory /proﬁles/CTP/conﬁguration/
com.softwareag.platform.conﬁg.propsloader directory.

Check Java Service Wrapper #include Directives
The migration utility migrates #include directives to the end of the new
custom_wrapper.conf ﬁle; check them and adjust as necessary. The
custom_wrapper.conf ﬁle is located in the Software AG_directory /proﬁles/CTP/
conﬁguration directory.
Note:

As noted in the Software AG Infrastructure Administrator's Guide, you should
never modify the wrapper.conf ﬁle unless instructed to do so by Software AG.
If you did so, however, manually copy values for properties you modiﬁed
in the old wrapper.conf ﬁle to the corresponding properties in the new
custom_wrapper.conf ﬁle.

Where to Go from Here
If you see product-speciﬁc chapters for your products after this chapter, perform
the tasks in those chapters in the exact order in which the chapters and tasks are
presented in this guide. The order of performance is critical because your products
have many inter-dependencies, including a shared infrastructure. Then go to
"Migrate Event Infrastructure and Perform Final Upgrade Tasks for All Products" on
page 125 and complete the tasks in that chapter.
If you do not see product-speciﬁc chapters for your products after this chapter, go to
"Migrate Event Infrastructure and Perform Final Upgrade Tasks for All Products" on
page 125 and complete the tasks in that chapter.
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Read and Complete All Previous Chapters
Before performing any task in this chapter, read all chapters that precede this chapter
carefully and complete all tasks that apply to your products in the order in which they
are presented in those chapters.

Migrate Terracotta
This section explains how to migrate Terracoa clients and servers that are deployed in
support of webMethods products. For all other setups, see the Terracoa BigMemory
Max documentation.
Follow the instructions in Using Terracoa with webMethods Products to install the 4.1.4 or
later license key and tc-conﬁg.xml ﬁle.
You must upgrade all Terracoa clients and servers in the cluster to the new release
before restarting the cluster.
If you have a single server:
1. Shut down your old Terracoa Server Array.
2. Start the new Terracoa Server Array.
If you have a mirror group consisting of an active server and a mirror server:
1. Shut down the old mirror server.
2. Shut down the old active server.
3. Start the new active server.
4. Start the new mirror server.

Migrate Universal Messaging
Before Migrating
If you are upgrading a Universal Messaging cluster, read webMethods Universal
Messaging Clustering Guide.
If the new and old Universal Messaging installations are on the same machine, make
sure the old installation is shut down.
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Run the Universal Messaging Migration Utility
The Universal Messaging migration utility migrates server instances within the old
installation to the new installation. This includes migrating each old instance’s data
directory to the corresponding new instance. The migration utility also creates instances
of Template Applications and Enterprise Manager, if you installed them in the new
installation.
For a general description of migration utility behavior, see "Migration Utilities" on page
42.

Perform a Custom Migration
1. On the machine that hosts the new Universal Messaging, open a command window
or shell, go to the new_Software AG_directory /UniversalMessaging/tools/migrate
directory, and run the command migrate.{bat|sh}.
2. The utility asks for the full path to the Software AG directory that contains the old
Universal Messaging installation or the ZIP ﬁle you made earlier.
3. The utility asks whether to import migration seings. Enter N.
4. The utility asks which Universal Messaging instance to migrate and lists the
instances in the old installation. To specify multiple instances, separate them using
commas.
9.8 and higher upgrade: To migrate all instances, press Enter without specifying any
instances.
5. The utility asks whether to export your seings. If you want to perform other
migrations by importing the seings from this session, enter Y. If not, enter N.
6. The utility asks whether to begin migration. If you enter Y, the utility migrates the
data you selected.

Migrate Using Imported Settings
Imported seings can come from the following:
Seings you exported from a custom migration. These seings are stored in a ﬁle
named migrate.dat in the new_Software AG_directory /UniversalMessaging/tools/
migrate directory from which you ran the custom migration. Copy the migrate.dat
ﬁle to any directory on machines that host new Universal Messaging installations to
which you want to migrate data.
Seings in the default migrations provided with Universal Messaging. For each old
release, the seings are stored in a ﬁle named migrateold_release sbs.dat ﬁle provided
by Software AG in the new_Software AG_directory /UniversalMessaging/tools/migrate
directory. The seings tell the migration utility to migrate the data listed under "Run
the Universal Messaging Migration Utility" on page 51.
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Migrate Using Custom Imported Settings with Prompting
1. On the machine that hosts the new Universal Messaging, open a command window
or shell, go to the new_Software AG_directory /UniversalMessaging/tools/migrate
directory, and run the command migrate.{bat|sh}.
2. The utility asks for the full path to the Software AG directory that contains the old
Universal Messaging installation or to the ZIP ﬁle you made earlier.
3. The utility asks whether to import migration seings. Enter Y and, when prompted,
provide the full path to the migrate.dat ﬁle.

9.5, 9.6, or 9.7 Upgrade: Migrate Using Custom Imported Settings without
Prompting (Silent)
On the machine that hosts the new Universal Messaging, open a command window or
shell, go to the new_Software AG_directory /UniversalMessaging/tools/migrate directory,
and run the command below. If an error occurs, the utility exits.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory |ZIP file}
-importFile migrate.dat
-silent true

9.8 and Higher Upgrade: Migrate Using Default Imported Settings without
Prompting (Silent)
On the machine that hosts the new Universal Messaging, open a command window or
shell, go to the new_Software AG_directory /UniversalMessaging/tools/migrate directory,
and run the command below. For the migrateold_release sbs.dat ﬁle, specify old_release
without periods (for example, 980, or 9100).
If you want to migrate all instances, do not specify -instanceName.
If an error occurs, the utility exits.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory |ZIP file}
[-instanceName name [,name ,name ...]]
-importFile migrateold_release sbs.dat
-silent true

Migrate Custom Changes and Data Directory
1. In release 9.8, the nserver.conf and nserverdaemon.conf ﬁles were combined into a
single ﬁle named Server_Common.conf. The Server_Common.conf ﬁle is stored in
the new_Software AG_directory /UniversalMessaging/server/umserver/bin directory.
9.5, 9.6, or 9.7 upgrade: If you made any custom changes to the nserver.conf
or nserverdaemon.conf ﬁle for an old instance, make the same changes to the
Server_Common.conf ﬁle for the corresponding new instance. The nserver.conf
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and nserverdaemon.conf ﬁles are stored in the old_Software AG_directory /nirvana/
server/umserver/bin directory.
9.8, 9.9, or 9.10 upgrade: If you made any custom changes to the
Server_Common.conf ﬁle for an old instance, make the same changes in the
Custom_Server_Common.conf ﬁle for the corresponding new instance.
9.12 or 10.0 upgrade: If you made any custom changes to the
Server_Common.conf or Custom_Server_Common.conf ﬁle for an old instance,
make the same changes in the Custom_Server_Common.conf ﬁle for the
corresponding new instance.
2. If the data directory for an old instance was not in the default location speciﬁed in
the Software AG Installer, the migration utility did not migrate the data directory.
The default location for the data directory is the new_Software AG_directory /
UniversalMessaging/server/instance /data directory. You can use the old data
directory in the old location or copy it to a new location. If you copy it, edit the
DDATADIR parameter in the Server_Common.conf ﬁle for the new instance to point
to the new data directory location.

Delete the Adapter .nst Files
If the new instance is on a diﬀerent machine than the old instance, go to the new_Software
AG_directory /UniversalMessaging/server/server_instance/data/RealmSpeciﬁc directory
and delete the adapter.nst and adapters_old.nst ﬁles.

9.5 or 9.6 Upgrade: Prepare to Use webMethods Messaging (Native
Pub-Sub)
If you plan to use the Integration Server or Microservices Container feature called
webMethods Messaging (also known as native pub-sub) with Universal Messaging, do
the following:
1. Start Enterprise Manager.
2. Select the realm, click the Conﬁg tab, and then expand Protobuf Conﬁg.
3. Double-click the FilterProtobufEvents property and set it to true.

Migrate webMethods Broker
Types of Migration
Migrate from Old webMethods Broker to New Universal Messaging
For instructions, see Migrating from webMethods Broker to webMethods Universal Messaging.
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Migrate from Old webMethods Broker to New webMethods Broker
In the 9.7 and later webMethods releases, the webMethods Broker release number is
still 9.6 and is the same release that was available with the webMethods 9.6 release. For
most types of upgrade, the tasks you perform depend on whether the new machine is
the same as or compatible with the old machine, where “compatible” means the new
machine has a similar hardware architecture that is running on the same or a higher
version of the same operating system.
Type of Upgrade

Instructions

9.6 and higher upgrade: The old
webMethods Broker resides on its
own machine, and you are going
to continue using it with the new
webMethods release.

Point 10.1 Broker clients, including
Integration Server or Microservices
Container 10.1, to the old webMethods
Broker.

9.5 upgrade: You installed the new
webMethods Broker on an IBM System
z machine that is running SUSE
Linux Enterprise Server or Red Hat
Enterprise Linux.

Create new storage and then migrate
the Broker Server conﬁguration from
the old storage to the new storage
using the webMethods Broker export
\import utilities. For instructions, see
Administering webMethods Broker 9.6.

You installed the new webMethods
Broker on a machine that is not
compatible with the old machine.

Create new storage and then migrate
the Broker Server conﬁguration from
the old storage to the new storage
using the webMethods Broker export
\import utilities. For instructions, see
Administering webMethods Broker 9.6.

You installed the new webMethods
Broker on the same machine as the
old webMethods Broker, or on a
machine that is compatible with the
old machine.

Follow the instructions in Create a
Broker Server and Use the Old Storage,
below.

Create a Broker Server and Use the Old Storage
1. Back up the old data directory.
2. Go to the old_Software AG_directory /Broker/bin directory and back up the old
awbrokermon.cfg ﬁle.
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3. Open the awbrokermon.cfg ﬁle and note the location of the old data directory as
speciﬁed on the dataDir parameter.
4. Stop the old Broker Server, go to the old_Software AG_directory /Broker/bin directory,
and run this command:
server_config remove full_path_to_old_data_directory

When asked whether to remove the Broker Server from the Broker Monitor
conﬁguration, enter Y.
5. If you need to copy the data directory to a new location (for example, because the
old and new webMethods Broker installations are on diﬀerent machines), do the
following:
a. Copy the old data directory to the new location.
You might have old storage ﬁles (for example, .stor and .data ﬁles) that were
located outside the old data directory. You can copy these ﬁles to the new data
directory, or you can copy these ﬁles to a location outside the new data directory.
b. On the machine that hosts the new webMethods Broker, open a command
window or shell, go to the new_Software AG_directory /Broker/bin directory, and
run the command below. The command conﬁgures the Broker Server to use the
new data directory paths for the old storage ﬁles.
If you copied old storage ﬁles to a location outside the new data directory, use
the -qs_map_file option for each old storage ﬁle to map the ﬁle’s location on the
old machine to the ﬁle’s location on the new machine.
server_config relocate full_path_to_new_data_directory
[-qs_map_file full_path_to_old_storage_file_in_old_location
full_path_to_copy_of_storage_file_in_new_location ]

6. If you are migrating from and to multi-home machines (that is, machines that have
multiple network interfaces and IP addresses), open the awbroker.cfg ﬁle and
update the broker-ipaddress conﬁguration to point to the new machine. If you do
not, you might experience a port binding error when you create the Broker Server.
7. Create the Broker Server. On the machine that hosts the new webMethods Broker,
open a command window or shell, go to the new_Software AG_directory /Broker/bin
directory, and run the appropriate command below. Specify the same port for the
new Broker Server that you used for the old Broker Server.
Location of Old
Data Directory
Old location
New location

Command

server_config add full_path_to_old_data_directory
-k 9.6_license_file -p old_port
server_config add full_path_to_new_data_directory
-k 9.6_license_file -p old_port
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Broker Server details are automatically added to the Broker Monitor startup
conﬁguration.
8. If you installed the new webMethods Broker on a diﬀerent machine than the old
webMethods Broker but you could not use the same host name for the new machine,
update the host name in the awbroker.cfg ﬁle.
9. Make sure the new Broker Server is running, as follows:
System

Steps

Windows

a. Open the Windows Services window and make sure the status of
the Software AG Broker Server 9.6(port ) service is Started.
b. Right-click the service and click Properties. Make sure the Path to
Executable ﬁeld points to the awbroker ﬁle for 9.6.

UNIX

a. Run the command ps -ef | grep awbroker, which prints
all running Broker processes including the path to the
executable. Make sure the output text shows a line like this:

full_path_to_new_Software AG_directory/Broker/bin/
awbroker -d full_path_to_new_data_directory

b. Make sure the awbroker process is running and that it is running
from the 9.6 awbroker ﬁle.
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Read and Complete All Previous Chapters
Before performing any task in this chapter, read all chapters that precede this chapter
carefully and complete all tasks that apply to your products in the order in which they
are presented in those chapters.

Before Migrating
1. If you are upgrading a My webMethods Server cluster, read " My webMethods
Server Requirements" on page 22.
2. If the new and old My webMethods Servers are on the same machine, make sure the
old My webMethods Server is shut down.

Run the My webMethods Server Migration Utility
The My webMethods Server migration utility migrates the following:
My webMethods Server server instances.
If the old My webMethods Server hosted Business Console, the user preferences,
AppSpaces, and gadgets for Business Console.
Java Service Wrapper customizations you made in the old custom_wrapper.conf
ﬁles, including #include directives and comments (but not associated properties).
For a general description of migration utility behavior, see "Migration Utilities" on page
42. The log4j.properties ﬁle for My webMethods Server is located in the new_Software
AG_directory /MWS/bin/migrate/resources directory.

Perform a Custom Migration
1. On the machine that hosts the new My webMethods Server, open a command
window or shell, go to the new_Software AG_directory /MWS/bin/migrate directory,
and run the command migrate.{bat|sh}.
2. The utility asks for the full path to the Software AG directory that contains the old
My webMethods Server installation or the ZIP ﬁle you made earlier.
3. The utility asks whether to import migration seings. Enter N.
4. For each instance in the old My webMethods Server installation, the utility asks the
following:
a. Whether to migrate the instance.
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b. Whether to use the live database or a cloned database with the migrated instance.
If you respond that you are using a cloned database, the utility prompts for the
database URL, user, and password.
Note:

You cannot use a new database that contains no data.

c. If the old instance was connected to Universal Messaging, whether to use the
old Universal Messaging URL or a new URL for the migrated instance. If you
respond that you want to use a new URL, the utility prompts for the URL.
If the old instance was not connected to Universal Messaging, whether to
specify a connection to Universal Messaging now or at some later time. If you
respond that you want to specify the connection now, the utility prompts for the
Universal Messaging URL.
5. The utility asks whether to export your seings from this session. If you want to
perform other migrations by importing the seings from this session, enter Y. If not,
enter N.
6. The utility asks whether to begin migration. If you enter Y, the utility migrates the
instances you speciﬁed. If migration completes successfully, the utility also does the
following:
Deletes old conﬁguration ﬁles that are not used by the new My webMethods
Server, and deletes old properties that are not used by the new My webMethods
Server from the new conﬁguration ﬁles.
If the old My webMethods Server used the embedded database, copies the
database tables from the old My webMethods Server to the new My webMethods
Server and converts the tables to the new format.
Synchronizes the My webMethods Server installation directory with the
database.
If you speciﬁed a URL for Universal Messaging, updates the existing JNDI
URL parameter or adds a new JNDI URL parameter to the cluster.xml ﬁle, as
appropriate.

Migrate Using Imported Settings
Imported seings can come from the following:
Seings you exported from a custom migration. These seings are stored in
a ﬁle named migrate.dat in the new_Software AG_directory /MWS/bin/migrate
directory. Copy the migrate.dat ﬁle to any directory on machines that host new My
webMethods Server installations to which you want to migrate data.
Seings in the default migrations provided by Software AG with My
webMethods Server. For each old release, the seings are stored in a ﬁle named
migrateold_release sbs.dat ﬁle in the new_Software AG_directory /MWS/bin/migrate
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directory. The seings tell the migration utility to migrate all instances within the old
installation to the new installation, and to use the live database.

Migrate Using Custom Imported Settings with Prompting
1. On the machine that hosts the new My webMethods Server, open a command
window or shell, go to the new_Software AG_directory /MWS/bin/migrate directory,
and run the command migrate.{bat|sh}.
2. The utility asks for the full path to the old Software AG installation directory or to
the ZIP ﬁle you made earlier.
3. The utility asks whether to import migration seings. Enter Y and, when prompted,
provide the full path to the migrate.dat ﬁle.

Migrate Using Default Imported Settings without Prompting (Silent)
You can migrate in silent mode when the old and new My webMethods Server
installations are identical (for example, they are hosting the same user interfaces for
other products).
On the machine that hosts the new My webMethods Server, open a command window
or shell, go to the new_Software AG_directory /MWS/bin/migrate directory, and run the
command below. For the migrateold_release sbs.dat ﬁle, specify old_release without
periods (for example, 980, or 9100).
If you want to migrate all instances, do not specify -instanceName.
If an error occurs (for example, the installations are not identical), the utility exits.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory |ZIP file}
[-instanceName name [,name ,name ...]]
[-cloneDbURL URL -cloneDbUser user -cloneDbPassword password ]
-importFile migrateold_release sbs.dat
-silent true

Migrate Using Custom Imported Settings without Prompting (Silent)
You can migrate in silent mode when the old and new My webMethods Server
installations are identical (for example, they are hosting the same user interfaces for
other products).
On the machine that hosts the new My webMethods Server, open a command window
or shell, go to the new_Software AG_directory /MWS/bin/migrate directory, and run the
command below.
If an error occurs (for example, the installations are not identical), the utility exits.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory |ZIP file}
-importFile full_path_to_ migrate.dat
-silent true
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Check Java Server Wrapper #include Directives
The migration utility migrates #include directives to the end of the new
custom_wrapper.conf ﬁle; check them and adjust as necessary. The
custom_wrapper.conf ﬁle is located in the Software AG_directory /proﬁles/MWS_instance /
conﬁguration directory.
Note:

As noted in the Software AG Infrastructure Administrator's Guide, you should
never modify the wrapper.conf ﬁle unless instructed to do so by Software AG.
If you did so, however, manually copy values for properties you modiﬁed
in the old wrapper.conf ﬁle to the corresponding properties in the new
custom_wrapper.conf ﬁle.

Initialize a My webMethods Server Instance
The initializing process might take several hours.
1. Initialize the new My webMethods Server server instance by going to the
new_Software AG_directory /MWS/bin directory and running this command:
mws.{bat|sh} -s instance init

The new components are deployed, and then the instance shuts down automatically.
Restart the instance.
2. If the old and new My webMethods Server installations are on diﬀerent machines,
verify the host name for the new installation as follows:
a. Log on to one of the new My webMethods Server instances as Administrator and
go to the Administration > My webMethods> Cluster Settings > Advanced Web and Cluster
Configuration for MWS page.
b. If the host name is not correct in the Host and MWS Front End URL ﬁeld, update the
host name.
c. Go to the Cluster Status and Control page and restart the instance.

Switch from Clone to Live Database
If you used a clone database to test your new installation (recommended), and you
later want to use your live database with the new installation you tested, you must
run the My webMethods Server migration utility again to make the switch. The utility
synchronizes the My webMethods Server installation directory with the database.
1. Run the My webMethods Server migration utility again.
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2. Migrate each server instance again. When the utility asks for the database to use with
each instance, choose the live database.
3. When the migration utility asks whether to delete or keep the migrated instances in
the new installation, choose to delete the migrated instances.

Complete the Business Rules Upgrade
1. If the new installation directory has a diﬀerent name than the old installation
directory, check the validity of the ﬁle system location used by Deployer for
Business Rules asset deployment, and restart My webMethods Server if updates
are necessary. For instructions, see Working with Business Rules in My webMethods,
chapter "Hot Deploying and Merging Rule Projects with webMethods Deployer" and
section "Conﬁguring My webMethods Server."
2. If you use business veriﬁcation or data providers, log on to one of the new My
webMethods Server instances as Administrator and go to the Administration > My
webMethods > System Settings > webMethods Business Rules Settings page. Update the
seings as necessary and save the changes.
For more information, see Working with Business Rules in My webMethods. For
business veriﬁcation, see chapter "Rule Veriﬁcation Overview" and section
"Conﬁguring a Server Connection for a PreconﬁguredVeriﬁcation." For data
providers, see chapter "Working with Decision Tables" and section "Conﬁguring a
Server Connection for a Preconﬁgured Data Provider Service."
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Read and Complete All Previous Chapters
Before performing any task in this chapter, read all chapters that precede this chapter
carefully and complete all tasks that apply to your products in the order in which they
are presented in those chapters.
Note:

Steps for Microservices Container are identical to those for Integration Server.

Packages
This guide refers to diﬀerent types of packages for Integration Server, as follows:
Custom packages. These include Integration Server packages created by users in
Software AG Designer and business process runtime packages generated by users
from Software AG Designer.
Hosted packages. These are packages provided by Software AG on the Software AG
Installer, where they are listed under Integration Server on the product selection tree.
On the tree, they are listed using their product names. However, in the ﬁle system
and within Integration Server, they are listed under their package names, and those
names start with Wm. For this reason they are also called Wm packages.
Examples of hosted Wm packages are ActiveTransfer (WmMFT), Process Engine
(WmPRT), Trading Networks (WmTN), adapters, and eStandards Modules.
When you installed the new Integration Server, the Software AG Installer created a
server instance and copied all Wm packages and language packs you selected on the
product selection tree into a package repository. The installer let you choose whether
to install the selected Wm packages on the instance. (The installer always installs the
language packs you selected on the instance.)

Before Migrating
1. If you are upgrading an Integration Server cluster, read " Integration Server or
Microservices Container Clustering Requirements" on page 22.
2. If you are upgrading an Integration Server that hosts Deployer, follow the
instructions in "Migrate the Asset Build Environment, Deployer, and Application
Platform" on page 95.
3. If the new and old Integration Servers are on the same machine, make sure the old
Integration Server is shut down.
4. The migration utility will scan the old installation for custom packages. However,
it will not ﬁnd custom packages whose names start with Wm, as this naming
convention is used for packages provided by Software AG. If you have custom
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packages whose names start with Wm, and you want to migrate them, go to the
new_Software AG_directory /IntegrationServer/bin/migrate directory, open the
packages.cnf ﬁle, and add a <value name><\value> tag that identiﬁes those custom
packages (for example, <value name="WmFINMessages">WmFINMessages</
value>).
Note:

To simplify future upgrades, and as a general best practice, do not use the
naming convention Wm name for custom packages.

Run the Integration Server Migration Utility
The Integration Server migration utility can migrate the following:
Custom (user-created) packages.
Password store, and passwords.
Integration Server conﬁguration ﬁles.
Conﬁguration for hosted products, such as Trading Networks.
JAAS conﬁguration ﬁles.
JDBC connection pool conﬁgurations, database drivers, and functional aliases.
If the old Integration Server hosted Wm packages and those Wm packages also exist
on the new Integration Server, the conﬁguration ﬁles for those packages.
Java Service Wrapper customizations you made in the old custom_wrapper.conf
ﬁles, including #include directives and comments (but not associated properties).
Starting in 9.5, custom (user-created) jar ﬁles.
9.6 and higher upgrade: If the old Integration Server installation has multiple server
instances, you run the migration utility once for each instance you want to migrate. You
can have the utility migrate old instances to new instances you created after installation
or to new instances that the utility creates for you.
For a general description of migration utility behavior, see "Migration Utilities" on page
42.

Perform a Custom Migration
1. On the machine that hosts the new Integration Server, open a command window
or shell and go to the new_Software AG_directory /IntegrationServer/bin/migrate
directory.
2. Run the command migrate.{bat|sh}.
3. The utility asks for the full path to the Software AG directory that contains the old
Integration Server installation or the ZIP ﬁle you made earlier.
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4. 9.6 and higher upgrade: If the old Integration Server installation has more than one
server instance, the utility asks which instance to migrate and lists the instances in
the old installation.
The utility then asks for the name of an instance to be the target of the migration. If
you want the utility to migrate to the instance that was created during installation of
the new Integration Server, enter the name of that instance. If you want the utility to
create an instance and migrate to this new instance, enter a name that does not exist
in the new installation.
If Wm packages exist on the old instance, and the same Wm packages exist in the
new package repository, the utility will install those Wm packages from the new
package repository on the new instance. If language packs exist in the package
repository, the utility will install those language packs on the new instance.
5. The utility asks whether to import migration seings. Enter N.
6. The utility asks whether to migrate custom packages. If you choose to migrate all
custom packages, the utility migrates the following:
Custom packages.
The WmChemPayloads, WmPapinetPayloads, WmRNPips, WmFINMessages,
and WmFIXMessages packages, if present. These packages contains IS
documents for the corresponding eStandards Modules and the schemas for those
documents.
If you choose to migrate selected packages only, the utility lists each of the packages
above and asks whether to migrate it.
7. The utility asks whether to migrate the password store, and whether to migrate
passwords.
8. The utility asks whether to migrate Integration Server conﬁguration ﬁles. If you
choose to migrate selected conﬁguration ﬁles only, the utility lists each conﬁguration
ﬁle and asks whether to migrate it. There are about 50 conﬁguration ﬁles.
9. The utility asks you to specify the behavior to use for new properties that have
been added to the new Integration Server and existing properties that have new
defaults in the new Integration Server. If you choose to specify the behavior to use,
the utility lists each property and asks whether to use new behavior or preserve
existing behavior. You can also read about these properties in the Integration Server
readme.
10. The utility asks whether to migrate functional aliases, database driver
conﬁgurations, and JDBC connection pool conﬁgurations. If you enter Y for JDBC
connection pool conﬁgurations, the utility asks whether to use the live database or
a cloned database with each migrated connection pool. If you respond that you are
using a cloned database for the migrated connection pool, the utility asks for the
database URL, user, and password.
11. If the Integration Server hosts Wm packages, the utility asks whether to migrate
the conﬁguration ﬁles for those packages. Examples of hosted Wm packages are
ActiveTransfer (WmMFT), Process Engine (WmPRT), adapters, and eStandards
Upgrading Software AG Products Version 10.1

66

M

Odd Header
Migrate Integration Server, Microservices Container, and Hosted Wm Packages

Modules. For some products, you might see additional prompts for migrating other
data.
12. The utility asks whether to migrate custom jar ﬁles. If you choose to migrate selected
custom jar ﬁles only, the utility lists each custom jar ﬁle and asks whether to migrate
it.
13. If the Integration Server hosts Trading Networks, the utility asks whether to migrate
Trading Networks information. If you enter Y, the utility asks the following:
a. Whether to migrate the Trading Networks conﬁguration ﬁle. If you enter Y,
the utility copies the conﬁguration properties from the old Trading Networks
installation directory, adds them to the new conﬁguration properties in the
new Trading Networks, and replaces the properties.cnf ﬁle in the new_Software
AG_directory /IntegrationServer/instances/instance /packages/WmTN/conﬁg
directory.
b. Whether to migrate Trading Networks data. This migration maps the data in the
Trading Networks database to the new table structure.
Note:

If you have a cluster of Trading Networks instances, the data is shared
by all instances, so only migrate the data for one instance.

c. Whether to migrate Trading Networks dashboard data. If you enter
Y, the utility purges records from the dashboard tables and populates
records from BIZDOC tables into dashboard tables. The dashboard
tables include TransactionSummaryData, CustomAributeVolumeValue,
TransactionSuccessFailedData, SuccessFailedChartDocIdMap, and
TransactionLateFAData.
14. The utility asks whether to migrate JAAS conﬁgurations.
15. The utility asks whether to migrate Java Service Wrapper customizations you
made in the old custom_wrapper.conf ﬁles, if any. These are migrated to the new
custom_wrapper.conf ﬁle.
16. The utility asks whether to export your seings. If you want to perform other
migrations by importing the seings from this session, enter Y. If not, enter N.
17. The utility asks whether to begin migration. If you enter Y, the utility migrates the
data you selected. If migration completes successfully, the utility also performs the
actions in "Other Actions Performed by the Migration Utility" on page 69.

Migrate Using Imported Settings
Imported seings can come from the following:
Seings you exported from a custom migration. These seings are stored in a ﬁle
named migrate.dat in the new_Software AG_directory /IntegrationServer/bin/migrate
directory from which you ran the custom migration. Copy the migrate.dat ﬁle to any
directory on machines that host the new Integration Server installations to which
you want to migrate data.
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Seings in the default migrations provided with Integration Server. For each old
release, the seings are stored in a ﬁle named migrateold_release sbs.dat ﬁle provided
by Software AG in the new_Software AG_directory /IntegrationServer/bin/migrate
directory. The seings tell the migration utility to migrate the data listed under
"Run the Integration Server Migration Utility" on page 65. For Integration Server
properties that are new or that have new defaults, the default migration chooses the
behavior that best preserves backwards compatibility.

Migrate Using Custom or Default Imported Settings with Prompting
1. On the machine that hosts the new Integration Server, open a command window or
shell, go to the new_Software AG_directory /IntegrationServer/bin/migrate directory,
and run the command migrate.{bat|sh}.
2. The utility asks for the full path to the Software AG directory that contains the old
Integration Server installation or to the ZIP ﬁle you made earlier.
3. 9.6and higher upgrade: If the old Integration Server installation has more than one
server instance, the utility lists the instances and asks which instance to migrate
from.
4. The utility asks for the name of a new server instance to be the target of the
migration. See this step in "Perform a Custom Migration" on page 65 for detailed
information on what to enter and how the utility proceeds.
5. The utility asks whether to import migration seings. Enter Y and, when prompted,
provide the full path to the migrate.dat ﬁle or the migrateold_release sbs.dat ﬁle. For
the migrateold_release sbs.dat ﬁle, specify old_release without periods (for example,
980, or 9100).

Migrate Using Custom or Default Imported Settings without Prompting (Silent)
If you are using a cloned database for Integration Server database components, specify
the -cloneDb options on the command as shown below. The migration utility uses the
cloneDb options only for the Integration Server database components. If you are using a
cloned database for the database components of hosted products (for example, Trading
Networks), perform a custom migration that identiﬁes the cloned database, then run the
command below with the migrate.dat ﬁle created by the custom migration.
On the machine that hosts the new Integration Server, open a command window or
shell, go to the new_Software AG_directory /IntegrationServer/bin/migrate directory, and
run the command below. For the migrateold_release sbs.dat ﬁle, specify the source release
number without periods (for example, 980).
If you do not specify -newInstanceName, the migrated instance will have the same name
as the old instance.
If an error occurs, the utility exits.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Integration Server_directory|ZIP_file}
-instanceName name [-newInstanceName name ]
-importFile {full_path_to_ migrate.dat|migrateold_release sbs.dat}
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[-cloneDbURL URL -cloneDbUser user -cloneDbPassword password ]
-silent true

Other Actions Performed by the Migration Utility
When migration completes successfully, the migration utility also does the following:
Deletes old conﬁguration ﬁles that are not used by the new Integration Server, and
deletes old properties that are not used by the new Integration Server from the new
conﬁguration ﬁles.
If the old Integration Server used the embedded database, the utility copies the
database tables from the old Integration Server to the new Integration Server and
upgrades the tables to the new format if necessary.
Adds a new property named "Validate schemas using Xerces" to existing
Web service descriptors, and sets the new property to the value the
wa.server.wsdl.validateWSDLSchemaUsingXerces parameter had in the old
Integration Server. The new property replaces the functionality provided by
that parameter. For information about the new property, see webMethods Service
Development Help.
If you are migrating Business Rules data, the utility upgrades Business Rule projects.
You might see XML parsing messages due to a Java bug; you can ignore these
messages.
If you are upgrading CloudStreams, the utility migrates conﬁguration artifacts
related to administering CloudStreams Server.

Complete the Integration Server Upgrade
Check Java Server Wrapper #include Directives
The migration utility migrates #include directives to the end of the new
custom_wrapper.conf ﬁle; check them and adjust as necessary. The
custom_wrapper.conf ﬁle is located in the Software AG_directory /proﬁles/IS_instance /
conﬁguration directory.
Note:

As noted in the Software AG Infrastructure Administrator's Guide, you should
never modify the wrapper.conf ﬁle unless instructed to do so by Software AG.
If you did so, however, manually copy values for properties you modiﬁed
in the old wrapper.conf ﬁle to the corresponding properties in the new
custom_wrapper.conf ﬁle.

Customize Integration Server Startup Files
The Integration Server startup scripts were changed in release 9.7. If you customized the
old scripts, see webMethods Integration Server Administrator’s Guide and the Integration
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Server readme for instructions on how to duplicate those customizations for the new
installation.

Update WSDLs
If you have Provider Web services that have an operation with ﬁeld names starting with
xml in the input signature, output signature, header, or faults, do the following:
1. Start the new Integration Server.
2. Review the migrationLog.txt ﬁle in the new_Software AG_directory /install/logs
directory. If you see this error:
A property watt.server.xml.ncname.encode.backward.compatibility exists in
config/server.cnf with value as true. Make sure you make the required changes
as specified in the upgrade documentation. Not doing so could have adverse
effects as support for this property may be dropped in a future release.

Update your WSDLs as follows:
a. Open the new Integration Server Administrator and point to the new Integration
Server.
b. Go to the Settings > Extended page. If you have the extended seing
wa.server.xml.ncname.encode.backward.compatibility and it is set to true, reset
it to false.
c. Regenerate the clients for all Provider Web services that have an operation with
ﬁeld names starting with xml in the input signature, output signature, header, or
faults.

9.5, 9.6, 9.7, or 9.8 Upgrade: Synchronize and Update Serial
webMethods Messaging Triggers
If you are using the new Integration Server with Universal Messaging, each
webMethods Messaging trigger with serial processing must have a corresponding
priority named object on Universal Messaging. However, each serial trigger you
migrated from your old Integration Server corresponds to a shared named object on
Universal Messaging. Create the corresponding priority named object by doing one of
the following:
If the Universal Messaging is a fresh installation (that is, it was not migrated from an
earlier release), synchronize the publishable document types with the provider using
Software AG Designer or the built-in service pub.publish:syncToProvider.
If the Universal Messaging was migrated from an earlier release, this Integration
Server is the only Integration Server that connects to Universal Messaging, and the
Shared Client Preﬁx property for the Universal Messaging connection alias is set to
No, disable and enable the Universal Messaging connection alias used by the trigger.
If the Universal Messaging was migrated from an earlier release, and this Integration
Server is not the only Integration Server that connects to Universal Messaging or
the Shared Client Preﬁx property is set to Yes, wait till the named object is fully
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drained and no new documents will be sent to it, and then use Universal Messaging
Enterprise Manager to delete the named object. You may need to quiesce document
publishers before deleting the named object. Then disable and enable the Universal
Messaging connection alias used by the trigger.

Connect Integration Server Functions to Database Components
Connect Integration Server and the Wm packages it hosts to their database components.
For instructions, see Installing Software AG Products.

Update Host Names
If your old and new Integration Server installations are on diﬀerent machines, update
the database components below to reﬂect the new machine.
If you had scheduled tasks that executed on Integration Server on speciﬁc machines in
your old installation, update the following:
Database
Component

Table

Column

ISInternal

IS_USER_TASKS

TARGET

If you want to be able to resubmit services that ran before you upgraded, update the
following:
Database
Component

Table

Column

ProcessAudit

WMRULEDIST

SERVERID

ISCore Audit,
ProcessAudit

WMDOCUMENT,
WMSERVICE, WMSERVICE4X,
WMSERVICEACTIVITYLOG,
WMSERVICEASSOC,
WMSERVICECUSTOMFLDS

SERVERID

Complete the ActiveTransfer Upgrade
For instructions and details on all steps below, see Managing File Transfers with
webMethods ActiveTransfer.
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1. Make sure that port values, host names and IP addresses, and local and remote ﬁle
paths in event ﬁle operations and the virtual ﬁle system (VFS) are correct for the new
ActiveTransfer installation.
Note:

When you start ActiveTransfer later, it will modify port names to comply
with Command Central standards. If ActiveTransfer ﬁnds duplicate port
names, it will add an underscore and a unique number to each name. If
a port name has a white space, it will replace that white space with an
underscore.

2. If you used custom keystore ﬁles in the old ActiveTransfer installation, make sure
they are available and accessible in the location speciﬁed in the new installation.
3. If you used the ﬁle sharing feature in the old ActiveTransfer installation, the
default shared ﬁle location is the old_Software AG_directory /IntegrationServer/
instances/instance /packages/WmMFT/resources/ TempAccounts directory.
Software AG recommends that you use a non-default shared ﬁle location in the new
installation, as follows:
a. Go to the old_Software AG_directory /IntegrationServer/instances/instance /
packages/WmMFT/conﬁg directory and open the properties.cnf ﬁle.
b. On the property mft.sharing.account.tempdir, specify the full path to any local
or shared directory. Use only forward slashes in the path (for example, D:/
activetransfer/sharedcontent/).
c. If you want to keep using the ﬁle share information from the old installation,
copy the contents of the old default shared location to the new shared location.

Complete the CloudStreams Upgrade
Migrate CloudStreams Artifacts in Custom Packages
1. Set the Integration Server property wa.server.hp.listRequestVars.
a. Open Integration Server Administrator and point to the new Integration Server.
b. Go to the Settings > Extended > Show and Hide Keys page.
c. Select the check box for the wa.server.hp.listRequestVars property and click
Save Changes.
d. Click Edit Extended Settings and set wa.server.hp.listRequestVars=asNeeded.
2. Back up any custom packages that contain CloudStreams artifacts, and then run
the public service pub.cloudstreams.migration:migrate, which is available in
the WmCloudStreams package. The service migrates old CloudStreams artifacts in
custom packages that depend on the WmCloudStreams package and updates them
to be compatible with the new CloudStreams. Artifacts include SOAP and REST
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connector services and connections. The utility logs the results of migration to the
Integration Server server log.
The input signature for the service is as follows:
Parameter

Description

allPackages

Boolean string. Optional. Set to:
true to migrate CloudStreams artifacts from all custom

packages that are dependent on WmCloudStreams.

false to migrate CloudStreams artifacts from only custom

packages speciﬁed on the packages parameter. This is the
default.
packages

Object. String array containing the names of custom packages to
migrate. You must specify at least one package name.

The output signature of the service is a parameter named Result that consists of an
array of iData records. The array contains a record for each custom package speciﬁed
in the input signature. The ﬁelds in each record are as follows:
Field

Description

packageName

String. Name of the custom package.

success

String. Value that indicates whether migration succeeded (true)
or failed (false).

message

String. Information about the migration, such as number of
CloudStreams artifacts found in the package and number of
CloudStreams artifacts that were successfully migrated.

info

Object. Optional. If the service issued info messages during the
migration, string array of the messages.

errors

Object. Optional. If the service issued errors during the
migration, string array of the errors.

Configure TLS 1.1 and 1.2 Trust Store
For SaaS back ends that have certiﬁcates that are not part of the JVM trust store, create
and apply a new JKS trust store in Integration Server with the certiﬁcates of the SaaS
back end. The trust store should contain all certiﬁcates in the certiﬁcate chain. This is a

Upgrading Software AG Products Version 10.1

73

M

Even Header
Migrate Integration Server, Microservices Container, and Hosted Wm Packages

standard practice for seing up secure exchange of certiﬁcates. If the trust store is not
present in such cases, certiﬁcate related errors will occur.
1. In Integration Server Administrator, go to the Security > Keystore page and create the
trust store. For detailed instructions, see the section on securing communications in
webMethods Integration Server Administrator’s Guide.
Note:

You can also create the trust store using a publicly available tool.

2. Apply the trust store in the connection's advanced property Trust Store Alias. For
detailed instructions, see the CloudStreams documentation for the Provider you are
using.

Complete the Mediator Upgrade
1. Set the default Universal Messaging server URL.
a. Go to the old_Software AG_directory /proﬁles/IS_instance /conﬁguration/
com.softwareag.platform.conﬁg.propsloader directory and open
the ﬁle com.softwareag.eda.nerv.properties. Copy the value on the
com.softwareag.eda.nerv.default.jms.provider property.
b. Go to the new_Software AG_directory /proﬁles/IS_instance /conﬁguration/
event/routing/services/UniversalMessaging directory and open the ﬁle
service-UniversalMessaging.json. Paste the value you just copied to the
Messaging.Provider.URL JSON property and then remove all '\' characters from
the value. For example, if the value is nsp\://localhost\:9000, change it to nsp://
localhost:9000.
2. Update Mediator property names.
a. Go to the new_Software AG_directory /IntegrationServer/instances/instance /
packages/WmMediator/conﬁg/resources directory and open the pg-conﬁg
properties ﬁle.
b. If the properties pg.nerv.muticast.stoponexception and
pg.nerv.PgMenConﬁguration.cache.size exist in the ﬁle, remove them.
c. If you conﬁgured these NERV properties in the old installation, modify the
property names listed below as indicated.
Old Name

New Name

pg.nerv.PgMenConﬁguration. pg.eda.PgMenConﬁguration.reportInterval
reportInterval
pg.nerv.PgMenConﬁguration. pg.eda.PgMenConﬁguration.perfDataEnabled
perfDataEnabled
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Old Name

New Name

pg.nerv.PgMenConﬁguration. pg.eda.PgMenConﬁguration.publishLifeCycleEvents
publishLifeCycleEvents
pg.nerv.PgMenConﬁguration. pg.eda.PgMenConﬁguration.publishErrorEvent
publishErrorEvents
pg.nerv.PgMenConﬁguration. pg.eda.PgMenConﬁguration.publishPolicyViolationEvents
publishPolicyViolationEvents
pg.nerv.PgMenConﬁguration. pg.eda.PgMenConﬁguration.emitToDefaultEndpoint
emitToDefaultEndpoint
pg.nerv.PgMenConﬁguration. pg.eda.PgMenConﬁguration.emitToSqlEndpoint
emitToSqlEndpoint
pg.nerv.jdbc.functional.pool.alias
pg.eda.jdbc.functional.pool.alias
3. Save EDA/Database seings.
a. Open Integration Server Administrator and point to the new Integration Server.
b. Go to Solutions > Mediator > Administration > EDA/Database.
c. Click Edit, do not make any changes, and click Save.

Complete Adapter Upgrades
If the old Integration Server hosted adapters, and you installed the same release or later
of those adapters on the new Integration Server, you migrated data for the adapters as
part of the Integration Server migration. For the adapters below, however, you must also
complete the indicated tasks. Then restart Integration Server.
For instructions on upgrading adapters when you are not also upgrading the host
Integration Server, see the adapter product documentation.

webMethods Adapter for JDBC
If the adapter connects to an Oracle RDBMS using an OCI driver, set these environment
variables on the new Integration Server machine:
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Platform

Environment Variable Setting

Solaris

LD_LIBRARY_PATH=\ORACLE_HOME\lib

HP

SHLIB_PATH=\ORACLE_HOME\lib

AIX

LIBPATH=\ORACLE_HOME\lib

Linux

LD_LIBRARY_PATH=\ORACLE_HOME\lib

webMethods Microsoft Package
For instructions on migrating webMethods Microsoft Package to a new Integration
Server on the same host as the old Integration Server, see the product documentation.

webMethods SAP Adapter
1. If the new Integration Server is on a UNIX system, set these environment variables
on the machine:
Platform

Environment Variable Setting

Linux, Solaris

LD_LIBRARY_PATH

HP

SHLIB_PATH

AIX

LIBPATH

2. If the new Integration Server is on a Windows system, go to the C:\WINDOWS
\system32\drivers\etc directory on the old Integration Server machine, open the
services ﬁle, and copy all entries that contain the phrase "sapgw" into the same ﬁle
in the new installation. Examples of these entries are sapgw00 3300\tcp, sapgw01
3301\tcp, sapgw02 3302\tcp, sapgw03 3303\tcp, sapgw04 3304\tcp, and sapgw05
3305\tcp.

Complete eStandards Module Upgrades
If the old Integration Server hosted eStandards Modules, and you installed the same
release or later of those modules on the new Integration Server, you migrated data
for the modules as part of the Integration Server migration. For the modules below,
however, you must also complete the indicated tasks. Then restart Integration Server.
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For instructions on upgrading eStandards Modules when you are not also upgrading the
host Integration Server, see the eStandards Modules product documentation.

webMethods SWIFTNet Module
Reconﬁgure the module. For instructions, see webMethods SWIFTNet Module Installation
and User’s Guide.
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Read and Complete All Previous Chapters
Before performing any task in this chapter, read all chapters that precede this chapter
carefully and complete all tasks that apply to your products in the order in which they
are presented in those chapters.

Migrate Software AG Designer
Before Migrating
1. Open the new Software AG Designer and point to a new workspace. For example,
you can accept the default workspacerelease (for example, workspace912)
2. Install any third-party features you need (for example, support for Subversion). The
Eclipse release installed with the new Software AG Designer is Eclipse 4.6.3, so make
sure any features you add are compatible with that Eclipse release.
3. If you exported your preferences before upgrading, import them as follows:
a. Go to the File > Import wizard. In the Select panel, go to General > Preferences
and click Next. In the From preference file ﬁeld, specify the .epf ﬁle to which you
exported your preferences. Click Finish.
b. Go to Window > Preferences. In the preferences window, go to the Java > Installed
JREs > Execution Environments page, if multiple JREs are listed, make sure JRE 1.8
is selected as the default, or remove older JREs from the list. Also update seings
that point to old product installations to point to new product installations
instead. For example, for My webMethods Server, update the Server > Runtime
Environments seings. For Application Platform, update the path to the runtime
instance, then review the messages on the Error tab to see whether any other
paths need to be updated.
c. Restart Software AG Designer.

Migrate Apama, Application Platform, Business Process, and
Business Rule Projects
1. If you are migrating Apama, copy any ﬁles you modiﬁed from the old work
directory to the new work directory.
2. If your projects are stored in a source control system, use the import wizard for that
system (for example, Import SVN > Project from SVN). If your projects are stored in the
Software AG Designer workspace, do the following:
a. Go to the File > Import wizard.
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b. In the Select panel, go to General > Existing Projects into Workspace and click Next.
c. In the Import Projects panel, do the following:
a. Click Select Root Directory and go to the workspace that contains a type of
project you want to import, or click Select Archive File and go to the directory
that contains a type of project you want to import.
b. In the Projects box, select the projects to import. Select Copy projects into
workspace. Click Finish.
3. if you are migrating Apama, use Project > Clean to force a rebuild of generated project
artifacts under Software AG Designer’s control.
4. Verify the following:
Product

Verify that...

Apama

All projects build without errors. If errors appear in the
Problems tab, click each error and resolve it.

Application
Platform

All projects compile without errors. If errors appear in the
Problems tab, click each error and resolve it. For example, if
you see errors indicating that classes cannot be resolved to a
type, edit the project’s class path conﬁguration.

Business
Process

All imported business process projects appear in the Solutions
tab under the Processes node.

Business
Rules

All imported business rules projects appear in the Solutions
tab under the Rules node.

5. If you imported Business Rule projects, right-click each project in the Rules Explorer
and then click Upgrade Project.
6. If you are migrating Apama
a. If any project imports event types from Digital Event Services, you might need to
re-import those event types. Open the project, open the EventTypeList ﬁle under
conﬁg/connectivity/DigitalEventServices, and click Sync from Digital Event Services.
If you see changes, save the ﬁle.
b. If you use ant to automate building and deploying your projects, export your
ant deployment scripts to an empty directory. Run the scripts to force a rebuild
of any generated artifacts within your projects (for example, Apama queries,
scenarios or Java\C\C++\.NET code using Apama APIs). Review the build
output for errors and warnings.
c. If you use Apama dashboard deployments, create new deployment packages and
install the deployment packages.
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Migrate Task Application Projects
1. In the new Software AG Designer, go to Window > Preferences > Server > Runtime
Environments. If the Installed server runtimes list does not include a My webMethods
Server from the new release, add one.
2. Go to Software AG > Task Development. In the preferences window, make sure all your
other task-related Software AG Designer preferences are correct, and then click OK.
3. Go to the File > Import wizard.
a. In the Select panel, go to Software AG > Existing CAF Projects into Workspace and then
click Next.
b. In the Import Projects panel, click Select Root Directory and go to the workspace or
source control system that contains your task application projects, or click Select
Archive File and go to the directory that contains your task application projects. In
the Projects box, select the projects to import.
c. Select Copy projects into workspace and then click Finish.
4. Make sure all imported task application projects appear in the Solutions tab, under
the Tasks node.
5. If errors appear in the Problems tab, click the Navigator tab. Right-click each task
application project, click CAF Tools, and click Repair CAF Project. If errors still appear,
restart Software AG Designer.
6. Publish the migrated task application projects to a My webMethods Server from the
new release. For instructions, see webMethods BPM Task Development Help.

Redo Attachment List Control Customizations in CAF Applications
In 9.10, the CAF Attachments List control was improved; for example, the Java appletbased drag and drop panel was replaced by an HTML5-based equivalent.
Your CAF applications were migrated when you ran the My webMethods Server
migration utility, but any customizations you made to the Attachments List control in
your CAF applications were not. Manually redo the customizations in the migrated CAF
applications.

Migrate CloudStreams Server Definitions and Projects
1. Start the new Software AG Designer.
2. Import CloudStreams Server deﬁnitions as follows:
a. Go to the CloudStreams Development perspective, then go to Window > Preferences.
On the Preferences dialog box, in the left navigation bar, go to Software AG
> CloudStreams Servers.
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b. Click Import, select the .properties ﬁle you exported, and click Open. Software AG
Designer asks whether to overwrite existing servers. Click OK, and then click OK
again to close the Preferences dialog box.
3. Import CloudStreams Governance projects as follows:
a. Go to the File > Import wizard. In the Select panel, go to Software AG
> CloudStreams Governance Project and then click Next.
b. In the Import CloudStreams Governance Project panel, specify the directory that
contains the projects you exported in the Select Root Directory ﬁeld. In the Projects
box, select the projects to import.
c. Select Copy projects into workspace and then click Finish.
d. In the CloudStreams Development perspective, make sure all imported governance
projects appear in the CloudStreams Governance tab.
4. Repeat the previous step to import CloudStreams Provider projects.

Migrate Integration Server or Microservices Container Definitions
1. In the new Software AG Designer, go to Window > Preferences. On the Preferences
dialog box, in the left navigation bar, go to Software AG > Integration Servers.
2. Click Import, select the .properties ﬁle you exported, and click Open. Software AG
Designer asks whether to overwrite existing servers. Click OK, and then click OK
again to close the Preferences dialog box.

Migrate the Business Process Runtime
Note:

If you have running process instances that are based on a process model
created before you upgraded, and you now want to regenerate that process
model in the new Software AG Designer, change the version number of the
process model to the next sequence number before regenerating it. If you
do not do so, the process instances will not behave as expected. When you
enable the new version of the process model for execution in My webMethods
Server, you will be asked if you want to upgrade running processes; respond
No.

Note:

Steps for Microservices Container are identical to those for Integration Server.

1. If you upgraded webMethods Broker, make sure the new Broker that will be used
by the Process Engines has the same name in 9.6 that it had in the old release. To do
so, open Integration Server Administrator and point to the new Integration Server
that connects to webMethods Broker. Go to the IS Settings > Messaging > webMethods
Messaging Settings page and check the Broker name.
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2. If you migrated process runtime packages (see "Run the Integration Server Migration
Utility" on page 65), make sure the packages exist in the new_Software AG_directory /
IntegrationServer/instances/instance /packages directory. The package names are the
project names or custom names you speciﬁed in Software AG Designer.
3. Open Integration Server Administrator and point to new Integration Servers
that host Process Engines. Go to the Settings > JDBC Pools page and connect the
ProcessEngine and ProcessAudit functions to their database components. For
instructions, see Installing Software AG Products.
4. In Integration Server Administrator, go to the Package > Management page and click
for the WmMonitor package.
5. If your old and new product installations are on diﬀerent machines and you want to
be able to resubmit processes and process steps that ran before you upgraded, follow
the steps below.
If the new Integration Server that hosts Monitor is connected to a messaging product
and has process model fragments, select the Resubmit to local IS check box, click
Submit, and then reload the package.
If the new Integration Server that hosts Monitor is not connected to any messaging
product and has no process model fragments, follow the steps below.
a. Clear the Resubmit to local IS check box, click Submit, and then reload the package.
b. In your database editor, go to the PRA_PROCESS_STEP database table in the
ProcessAudit database component and update the SERVERID column to point to
the new Integration Server that hosts Monitor.
6. Go to the Settings > Messaging > webMethods Messaging Trigger Management page and
make sure document retrieval is enabled for all webMethods Messaging triggers
on new Integration Servers. For instructions, see webMethods Integration Server
Administrator’s Guide.

Migrate Closed Loop Analytics
In "Migrate Software AG Designer" on page 80 you migrated all conﬁgurations
and data involved in Closed Loop Analytics. You must now update the JMS topic in
Universal Messaging from which Closed Loop Analytics collects escalation events, as
follows:
1. Start the Universal Messaging instance from the new release that you are using for
BPM, and then start the Enterprise Manager.
In the left panel, open the Realms tree and click the Universal Messaging instance
you are using for BPM.
In the right panel, click the JNDI tab and open the Topics tree. Delete the topic
for the escalation event type {hp://namespaces.softwareag.com/EDA/WebM/
Rules/CLA/1.0}ProcessEscalation.
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2. On the Universal Messaging instance host machine, go to the new_Software
AG_directory /jvm/jvm/bin directory and open a command window or shell. Create
a new topic for the escalation event type by entering the command below. Type the
command on one line with a space at each of the line breaks shown below.
java -jar new_Software AG_directory /common/lib/event-routing-jms-util.jar
bind nsp://locahost:9000
{http://namespaces.softwareag.com/EDA/WebM/Rules/CLA/1.0}ProcessEscalation
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Read and Complete All Previous Chapters
Before performing any task in this chapter, read all chapters that precede this chapter
carefully and complete all tasks that apply to your products in the order in which they
are presented in those chapters.

Configure and Start the Terracotta Server Array
If you are clustering Analytic Engines in the new release, you must conﬁgure and start
the Terracoa Server Array. For instructions, see Using Terracoa with webMethods
Products, Conﬁguring BAM, and the Terracoa BigMemory Max documentation.

Update Connection to Other Products
Update Connection to Process Engine
If you are using Optimize for Process, follow the steps below.
1. Open Integration Server Administrator and point to a new Integration Server that
hosts a Process Engine.
2. Go to the Packages > Management page and click

for the WmPRT package.

3. Click Settings in the left navigation bar and then click Edit Process Engine Settings.
4. In the JMS Server URL ﬁeld, identify the JMS provider host name and port as follows:
JMS Provider

URL Format

webMethods Broker

broker://host :port /Broker_name . The default port is 6849.

Universal Messaging

nsp://host :port . The default port is 9000.

5. Click Submit and then reload the WmPRT package.
6. Repeat these steps for every new Integration Server that hosts a Process Engine.

Update Connection to Optimize Support Package
If you are using Optimize built-in services, follow the steps below.
Note:

Steps for Microservices Container are identical to those for Integration Server.

Upgrading Software AG Products Version 10.1

88

M

Odd Header
Migrate Optimize and Infrastructure Data Collector

1. Open Integration Server Administrator and point to a new Integration Server that
hosts an Optimize Support package.
2. Go to the Packages > Management page and click

for the WmOptimize package.

3. Identify the Analytic Engine host machine and port. The default port is 12503.
4. In the JMS Server URL ﬁeld, identify the JMS provider host name and port as follows:
JMS Provider

URL Format

webMethods Broker

broker://host :port /Broker_name . The default port is 6849.

Universal Messaging

nsp://host :port . The default port is 9000.

5. Click Submit and then reload the WmOptimize package.
6. Repeat these steps for every Integration Server that hosts an Optimize Support
package.

Migrate Infrastructure Data Collector
Run the Infrastructure Data Collector Migration Utility
The Infrastructure Data Collector utility migrates the following:
Asset conﬁguration ﬁles.
SNMP, JAAS, JMX, SSH, security, log, platform debug, Web Services Stack, and
watchdog conﬁgurations.
Java Service Wrapper customizations you made in the old custom_wrapper.conf
ﬁles, including #include directives and comments (but not associated properties).
For a general description of migration utility behavior, see "Migration Utilities" on page
42.

Before Migrating
1. If the new and old Infrastructure Data Collectors are on the same machine, make
sure the old Infrastructure Data Collector is shut down.
2. If you want to migrate SNMP asset conﬁguration ﬁles, go to the
new_Software_AG_directory infrastructuredc/bin/migrate/old_release directory and
open the snmpMigration.properties ﬁle. Enter the full paths to the old and new
SNMP conﬁguration directories. The contents of the ﬁle show the format to use.
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Perform a Custom Migration
1. On the machine that hosts the new Infrastructure Data Collector, open a command
window or shell, go to the new_Software AG_directory /Infrastructuredc/bin/migrate
directory and run the command migrate.{bat|sh}.
2. The utility asks for the full path to the Software AG directory that contains the old
Infrastructure Data Collector installation or the ZIP ﬁle you made earlier.
3. The utility asks whether to import migration seings. Enter N.
4. The utility asks whether to migrate SNMP asset conﬁguration ﬁles. If you
respond Y, the migration utility will migrate the old ﬁles you identiﬁed in the
snmpMigration.properties ﬁle.
5. The utility asks whether to export your seings. If you want to perform other
migrations by importing the seings from this session, enter Y. If not, enter N.
6. The utility asks whether to begin migration. If you enter Y, the utility migrates the
data you selected.
If you chose to migrate asset conﬁguration ﬁles, and a ﬁle that has the same name
as an old ﬁle already exists in the new Infrastructure Data Collector installation,
the utility backs up the new ﬁle to the new_Software AG_directory /infrastructuredc/
migrationbackup directory before migrating the old ﬁle. The same is true for all
migrated directories and ﬁles.

Migrate Using Imported Settings
Imported seings can come from the following:
Seings you exported from a custom migration. These seings are stored in a ﬁle
named migrate.dat in the new_Software AG_directory /infrastructuredc/bin/migrate
directory from which you ran the custom migration. Copy the migrate.dat ﬁle to any
directory on machines that host new Infrastructure Data Collector installations to
which you want to migrate data.
Seings in the default migrations provided with Infrastructure Data Collector. For
each old release, the seings are stored in a ﬁle named migrateold_release sbs.dat ﬁle
in the new_Software AG_directory /infrastructuredc/bin/migrate directory. The seings
tell the migration utility to migrate the data listed in "Migrate Infrastructure Data
Collector " on page 89.
Migrate Using Custom or Default Imported Settings with Prompting
1. On the machine that hosts the new Infrastructure Data Collector, open a command
window or shell, go to the new_Software AG_directory /infrastructuredc/bin/migrate
directory, and run the command migrate.{bat|sh}.
2. The utility asks for the full path to the Software AG directory that contains the old
Infrastructure Data Collector installation or to the ZIP ﬁle you made earlier.
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3. The utility asks whether to import migration seings. Enter Y and, when prompted,
provide the full path to the migrate.dat ﬁle or the migrateold_release sbs.dat ﬁle. For
the migrateold_release sbs.dat ﬁle, specify old_release without periods (for example,
980, or 9100).
Migrate Using Custom or Default Imported Settings without Prompting
On the machine that hosts the new Infrastructure Data Collector, open a command
window or shell, go to the new_Software AG_directory /infrastructuredc/bin/migrate
directory, and run the command below. For the migrateold_release sbs.dat ﬁle, specify the
source release number without periods (for example, 980).
If an error occurs, the utility exits.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory |ZIP file}
-importFile {full_path_to_ migrate.dat|migrateold_release sbs.dat}
-silent true

Check Java Server Wrapper #include Directives
The migration utility migrates #include directives to the end of the new
custom_wrapper.conf ﬁle; check them and adjust as necessary. The
custom_wrapper.conf ﬁle is located in the Software AG_directory /proﬁles/InfraDC/
conﬁguration directory.
Note:

As noted in the Software AG Infrastructure Administrator's Guide, you should
never modify the wrapper.conf ﬁle unless instructed to do so by Software AG.
If you mistakenly modiﬁed the old wrapper.conf ﬁle, manually copy values
for properties you modiﬁed in the old wrapper.conf ﬁle to the corresponding
properties in the new custom_wrapper.conf ﬁle.

Deploy the Optimize Environment
Unless otherwise noted, see Conﬁguring BAM for detailed instructions on the Optimize
steps in the sections below.

Not Reuse the Old Optimize CCS Environment Definition
If you do not want to reuse your old Central Conﬁgurator System (CCS) Environment
deﬁnition, start the new My webMethods Server, open My webMethods, and conﬁgure
your new Optimize environment.
For Infrastructure Data Collector, when you deﬁne hosts, enter the same value in the
Host Name or IP Address ﬁeld of the Add\Edit Host dialog box that you had in the old
release.
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Note:

If the new value is not identical to the old value, you will have to stop
monitoring existing assets, rediscover them, and reselect them for monitoring
after you ﬁnish upgrading.

Skip to the step for deploying the new Optimize environment, below.

Reuse the Old Optimize CCS Environment Definition
To reuse the old CCS environment deﬁnition that you exported to ﬁle before installing
the new Optimize, follow the steps below.
1. Start the new My webMethods Server and open My webMethods.
2. Import the old CCS environment, as follows:
a. Go to the Applications > Administration > System-Wide > Environments > Define
Environments page.
b. Click Import Environment. On the Import Environments dialog box, click Browse,
go to the ﬁle to which you exported the old CCS environment, and click OK.
When prompted, conﬁrm the migration.
c. When asked "Do you wish to migrate the environment to the latest version?",
click Yes. The CCS imports the old environment and migrates it to the new
Optimize Logical Servers.
3. Update the database pool connection seings for the database pool deﬁnition
associated with the environment you imported, as follows:
a. Go to the Applications > Administration > System-Wide > Environments > Database Pool
Configuration page.
b. In the Pool column, click the imported database pool.
c. In the Pool Settings area, set the Minimum Connections ﬁeld to 8, and the Maximum
Connections ﬁeld to 60.
d. Make sure the database connection information is correct. In the Database
Connection area, click Test and make sure the message Test Passed displays at
the boom of the page.
e. Click Save.
4. Go to the Applications > Administration > System-Wide > Environments > Define Environments
page. Under Environment Name, click the environment you imported.
5. If you are using a diﬀerent JMS provider with the new release than you used with
the old release, do the following:
a. Click the Configure Servers tab. Under Configuration, open the Default Settings tree
and click JNDI Configuration.
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b. In the Naming Factory Type list, click the JMS provider you are using with the new
release. If you are using webMethods Broker, complete the Broker Name ﬁeld. If
you are using Universal Messaging, clear the ﬁeld. Click Save
c. Click the Map Endpoints tab. In the ﬁrst Incoming Connections ﬁeld for the JMS
Provider, type broker if you are using webMethods Broker or nsp if you are
using Universal Messaging. In the second ﬁeld, type the port number.
d. Click Save.
6. Validate the environment as follows:
a. Click each tab that shows the icon
except the Validate tab. If you change any
seings on a tab, and the tab has a Save buon, click Save.
b. When all tabs except the Validate tab show

, click the Validate tab.

7. Click Finish.

Deploy the New Optimize Environment
1. Start the new Optimize components you installed. These components can include the
Analytic Engine, Infrastructure Data Collector, and the Web Services Data Collector.
2. Start the JMS provider you are using with the new release.
3. Deploy your new Optimize environment. For instructions, see Conﬁguring BAM.
4. In My webMethods, go to the My webMethods > System Settings > Servers page.
If you have BPMS installed, select the BPM and BAM option and identify the new
Analytic Engine and the new Integration Server that hosts Monitor. For the hosts,
you can specify DNS name or IP address.
If you have BPMS installed, but are not using BPM (that is, you are using only
Optimize), select the BAM only option and identify the new Analytic Engine. For
the host, you can specify DNS name or IP address.
5. Start the Analytic Engine and then click Check Server Status to make sure the server is
available (green icon). It might take some time (for example, 15 minutes). Then click
Save.
6. Restart the Analytic Engine.

9.7 Upgrade: Start Monitoring 4.1 or Later Terracotta Server
Arrays
For instructions on each step, see Administering webMethods Optimize.
1. Start the new Infrastructure Data Collector.
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2. Go to Applications > Administration > Infrastructure Components > Discovery.
3. Delete all Terracoa (Asset) entries.
4. Rediscover 4.1 or later Terracoa Server Arrays you want to monitor.
5. Go to Applications > Administration > Infrastructure Components > Monitored Components.
Select Terracoa Server Array monitors, components, and KPIs.

Switch from webMethods Broker to Universal Messaging
If you were using webMethods Broker as your JMS provider in the old release, and are
using Universal Messaging in the new release, do the following:
1. Start Universal Messaging and open Universal Messaging Enterprise Manager.
2. Connect to a Universal Messaging instance, then click it.
3. Click the Config tab. Expand Global Values and set AllowRealmAdminFullAccess to
true.
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Read and Complete All Previous Chapters
Before performing any task in this chapter, read all chapters that precede this chapter
carefully and complete all tasks that apply to your products in the order in which they
are presented in those chapters.

Migrate the Asset Build Environment
Go to the old_Software AG_directory /common/AssetBuildEnvironment/master_build
directory and open the build.properties ﬁle. Copy the property values to the same ﬁle in
the new installation.

Migrate Deployer
Note:

Steps for Microservices Container are identical to those for Integration Server.

1. Make sure you have upgraded all source and target product servers that were
deﬁned in the old Deployer to the new release, and have migrated all product data
and assets to the new release, as instructed in the product-speciﬁc chapters earlier in
this guide.
Note:

Migrating Deployer projects does not convert the product assets in those
projects from their old release to the new release. The assets must be
migrated as instructed earlier in this guide.

2. Start the old host Integration Server. In the old Deployer, edit all connections to old
source and target product servers to point to the new source and target product
servers. You do not have to supply user names and passwords if you do not know
them. For instructions, see webMethods Deployer User’s Guide.
3. If you installed the new Deployer on the same machine as the old Deployer, you
might want the new Deployer to use the ports that were used by the old Deployer. If
so, do the following:
a. In the old Integration Server Administrator, point to the Integration Server that
hosts the old Deployer and go to the Security > Ports page.
b. Click Add Port, click webMethods\HTTP, and click Submit. Enter the port details,
click Yes for Enable, click WmRoot under the package name, and click Save
Changes.
c. Click Change Primary Port, click the new port, and click Update.
d. In the Access Mode column of the new port, click Edit. In the Edit Access Mode page
for the port, click Set Access Mode to Allow by Default. Click OK on the warning popUpgrading Software AG Products Version 10.1
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up. The message Successfully changed access mode for Port Service
Access Settings appears.
e. Disable the old port by clicking Yes in the Enabled column for that port.
4. Migrate Deployer seings, server aliases, target groups, and projects using the
instructions in "Migrate Integration Server, Microservices Container, and Hosted
Wm Packages" on page 63.

Migrate Application Platform
Before Migrating
If the new and old Integration Server instances that host the Application Platform
Support package are on the same machine, make sure the old Integration Server
instances are shut down.
If the new and old My webMethods Servers that host Application Platform projects
bundles are on the same machine, make sure the old My webMethods Servers are shut
down.

Run the Application Platform Migration Utility
The Application Platform migration utility migrates Application Platform conﬁguration
ﬁles that reside in Integration Server installations and Application Platform projects
bundles that reside in My webMethods Server installations.
The Application Platform migration utility runs without prompting you for any
information. If an error occurs, the utility exits.
For a general description of migration utility behavior, see "Migration Utilities" on page
42.
On each machine that hosts a new Integration Server instance that hosts the Application
Platform Support package or a new My webMethods Server that hosts Application
Platform projects bundles, open a command window or shell, go to the new_Software
AG_directory /common/migrate/AppPlatform/bin directory, and run the command
below. For the migrateold_release sbs.dat ﬁle, specify old_release without periods (for
example, 980, or 9100).
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory|ZIP_file}
-importFile migrateold_release sbs.dat
-silent true

Rebuild and Redeploy Application Platform Projects
Go to the new_Software AG_directory /install/log directory and open the migrationLog.txt
ﬁle. Check for this message:
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Project bundle /dev/installs/99oct2015/profiles/IS_default/
workspace/app-platform/deployer/bundles/greeter-web.jar
contains a package com.softwareag.applatform.sdk with import version
range [start_version , end_version ) that must be upgraded manually.

The message relates to semantic versioning of the packages used in your Application
Platform projects. For information, see the OSGi Alliance semantic versioning technical
whitepaper.
If the message exists, and you never created manifest ﬁles for Application Platform
projects, rebuild and redeploy the projects using Asset Build Environment and
Deployer.
If the message exists, and you did create manifest ﬁles for Application Platform projects,
edit the manifest ﬁles to include the end_version , and then rebuild and redeploy the
projects.
For instructions on rebuilding and redeploying Application Platform projects , see
webMethods Application Platform User’s Guide.
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Read and Complete All Previous Chapters
Before performing any task in this chapter, read all chapters that precede this chapter
carefully and complete all tasks that apply to your products in the order in which they
are presented in those chapters.

Before Migrating
If the new and old Apama are on diﬀerent machines, update deployment scripts (for
example, ant scripts and properties ﬁles) to specify the correct host names for the new
installation.
If the new and old Apama are on the same machine, make sure all processes from the
old installation are shut down.

Complete the Apama Upgrade
1. Run your ant scripts to force a rebuild of any generated artifacts within your projects
(for example, Apama queries, scenarios or Java\C\C++\.NET code using Apama
APIs). Check the build output for errors and warnings.
2. Inject your migrated applications into the new Apama by running them in your user
acceptance testing (UAT) environment. Scan the correlator logs for any errors or
warnings. Re-run all your system tests (for example, PySys test cases) and ensure
your application behaves as expected.
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Read and Complete All Previous Chapters
Before performing any task in this chapter, read all chapters that precede this chapter
carefully and complete all tasks that apply to your products in the order in which they
are presented in those chapters.

10.0 Upgrade: Migrate API Gateway
1. If the new and old API Gateway are on the same machine, make sure the old API
Gateway (and its host Integration Server) are shut down.
2. If you used custom keystore ﬁles in the old API Gateway installation, copy the ﬁles
to the same location in the new installation.
3. Start the new API Gateway, log on, make sure the API Gateway Event Data Store is
also started, and then shut down API Gateway.
4. Start the new Event Data Store by starting the service Software AG Event Data
Store 10.1 or by opening a command window or shell, going to the new_Software
AG_directory /EventDataStore/bin directory, and running the command startup.bat
5. Go to the new_Software AG_directory /IntegrationServer/
instances/instance_created_during_installation /packages/WmAPIGateway/migration
directory, open the MigrationHandlers.xml ﬁle, and list the API Gateway handlers
you want to migrate, separated by commas.
6. Open a command window or shell, go to the new_Software AG_directory /
IntegrationServer/instances/instance_created_during _installation /packages/
WmAPIGateway/migration directory, and run the command below.
migration.{cmd|sh}
–instance_name name_of_backup_API Gateway_instance
-isbackup full_path_to_backup_ZIP_file
-edsbackup full_path_to_backup_API Gateway_instance_name_directory
-backupFileName name_of_backup_Event_Data_Store_snapshot

When migration completes, the migration utility generates a migration.log and
a report in the new_SoftwareAG_directory /IntegrationServer/instances/instance /
packages/WmAPIGateway/migration directory.
7. Shut down Event Data Store, then restart API Gateway and Event Data Store.

Migrate API Portal
1. If the new and old API Portals are on the same machine, make sure the old API
Portal is shut down.
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2. If you installed the new API Portal in a clustered, high-availability setup, make sure
all nodes are running and accessible to the Zookeeper ensemble. Then register all the
nodes with the parent node by invoking the REST service shown below. The default
for the load balancer port is 18007.
Parameter

Value

End point

hp://load_balancer_host :load_balancer_port /acc/rest/nodes/

Method type

POST

Content type

application/json

Payload

{"nodename": "host_name ", "hostname": "host_name ",
"port": "cloud_agent_port ", "username": "Clous",
"password": "g3h31m“}

3. Start the new API Portal Cloud Controller.
4. Run this command:
acc> startall

5. Restore the old master tenant into the new API Portal from the backup ﬁle you
created earlier.
For
9.7

9.8

9.9
9.10
9.12
10.0

Run these commands...
acc> set acc config backup.restore.tenant.app.types = UMC
acc> restore tenant master from full_path_to_backup_file
username=your_user_name password=your_password
acc> set acc config backup.restore.tenant.app.types=ECP,ADS,UMC
acc> restore tenant master from full_path_to_backup_file
username=your_user_name password=your_password
acc> set acc config backup.restore.tenant.app.types=ECP,ADS,UMC
acc> restore tenant master from full_path_to_backup_file
username=your_user_name password=your_password
acc> restore tenant master from full_path_to_backup_file
username=your_user_name password=your_password

6. Earlier in this guide, you generated a list of tenants in the old API Portal. For each
old tenant on the list except the default tenant and the master tenant, create a
corresponding tenant in the new API Portal by running this command:
cmd> cd new_Software_AG_directory /API_Portal/server/bin/work/
work_apiportalbundle_s/tools/bin
cmd> y-tenantmgmt.bat -s http://load_balancer_host :load_balancer_port
-t tenant_name createTenant -u your_user_name -p your_password
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7. In the User Management Component at hp://host :port /umc, import the license for
each tenant you created.
8. In the new API Portal Cloud Controller, run these commands:
acc> stop apiportalbundle_s
acc> start apiportalbundle_s

9. For each new tenant you created, restore the data for the corresponding old tenant
into the new API Portal from the backup ﬁle you created earlier by running the
commands below. Each ﬁle has the ﬁle extension .acb.
Important: Inform API Portal users that they cannot work on the tenants during the
restoration process.
Important: If the new tenant contains any data, the data will be replaced by the data
you restore from the old tenant.
For
9.7
9.8
9.9
9.10
9.12
10.0

Run these commands...
acc> set acc config backup.restore.tenant.app.types = UMC, ABS, ADS, ECP
acc> restore tenant tenant_name from full_path_to_backup_file
username=your_user_name password=your_password

acc> restore tenant tenant_name from full_path_to_backup_file
username=your_user_name password=your_password

10. Run these commands:
acc> stop apiportalbundle_s
acc> start apiportalbundle_s

11. If you created a customized view of your old API Portal, you backed up the view.
For instructions on restoring the customized view from the backup, see the backup
and restore section in the webMethods API Portal Customization Guide.

Migrate CentraSite
CentraSite scripts migrate conﬁgurations from the old CentraSite and assets from the old
Registry Repository to the new CentraSite installation. They also transform and migrate
the LDAP conﬁguration from the old Registry Repository to the new CentraSite JAAS
conﬁguration.
1. Import conﬁgurations and assets from the ZIP ﬁle you created earlier. Open a
command window or shell, go to the new_Software AG_directory /CentraSite/utilities
directory, and run this command:
sbsImport.{cmd|sh} /full_path_to_ZIP_file
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An example of this command is ./sbsImport.sh /tmp/sbs_cs82_data.zip
2. Start the new CentraSite.
3. 9.5 or 9.6 upgrade: Transform and migrate the LDAP conﬁguration to the new JAAS
conﬁguration. From the new_Software AG_directory /CentraSite/utilities directory, run
this command:
CentraSiteCommand.{cmd|sh} generate JaasConfiguration -url CentraSite_new_URL
-user CentraSite_new_admin_user -password password

The script generates JAAS LoginModule entries that correspond to the
old LDAP conﬁguration and saves the entries in the jaas.conﬁg ﬁle in the
new_Software AG_directory /CentraSite/proﬁles/CTP/conﬁguration directory.
For each LDAP domain, the script creates user and group ﬁles that map
internal (CentraSite) properties to external (LDAP) properties and saves the
ﬁles in the new_Software AG_directory /CentraSite/proﬁles/CTP/conﬁguration/
com.softwareag.platform.conﬁg.propsloader directory.
4. If you use single sign-on with CentraSite, do the following:
a. Open the jaas.conﬁg ﬁle in the old and new Software AG_directory /proﬁles/CTP/
conﬁguration directories. Copy the following from the old ﬁle to the new ﬁle:
ServletHeaderLoginModule for extracting the user ID from the incoming
HTTP header.
SimpleNameMappingLoginModule, if you are using it.
Any other entries you are using to process the extracted user ID.
The new jaas.conﬁg ﬁle should look like this:
CentraSite {
com.softwareag.centrasite.security.cache.ShortTermTokenLoginModule sufficient;
com.softwareag.security.jaas.login.internal.InternalLoginModule sufficient
...
com.softwareag.security.sin.is.ldap.lm.LDAPLoginModule sufficient
...
com.softwareag.security.jaas.login.modules.ServletHeaderLoginModule
required
...
com.softwareag.security.jaas.login.modules.SimpleNameMappingLoginModule
required
...
com.softwareag.security.sin.is.ldap.lm.LDAPLoginModule required
...
};

The ShortTermTokenLoginModule establishes delegated authentication
in CentraSite to perform secured internal communication. The initial
InternalLoginModule is normally only for users in the INTERNAL domain, and
the initial LDAPLoginModule is for LDAP users that are logging in directly and
not via single sign-on. If you need only single-sign on logins, you can remove the
initial InternalLoginModule and LDAPLoginModule.
b. Set up your LDAP conﬁguration to resolve the extracted user ID via LDAP.
Modify the generated LDAP login module to enable single sign-on-related
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options, such as technical user. Apply LDAP single sign-on technical user
credentials if necessary.
5. Change any seings in CentraSite Control that you noted earlier.
6. If you installed plug-ins that are GUI extensions for CentraSite Control in the old
CentraSite installation, install them in the new CentraSite installation.
7. If you are using API Portal with CentraSite, republish all API Portal instances you
created in the old release to the new API Portal. For instructions, see the CentraSite
documentation.
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Read and Complete All Previous Chapters
Before performing any task in this chapter, read all chapters that precede this chapter
carefully and complete all tasks that apply to your products in the order in which they
are presented in those chapters.
Note:

Presto was renamed MashZone NextGen in release 9.10. This chapter will use
“Presto” or “the old product” to refer to releases prior to 9.10.

Overview
This chapter explains how to do the following:
Complete an upgrade to MashZone NextGen 10.1 from Presto 3.6, 3.7, 3.8, 3.9, or 9.9;
or from MashZone NextGen 9.10; or from MashZone NextGen Business Analytics
9.12 or 10.0.
Complete an upgrade to MashZone NextGen Explorer 10.1 from MashZone
NextGen Visual Analytics 9.12 or 10.0.

Migrate MashZone NextGen
MashZone NextGen stores all of its data, including mashups, mashables, apps and
workspaces, in its repository. To upgrade, you will set up the new MashZone NextGen
to use the old repository. If you deployed extensions to features of the old product (for
example, if you used scripting in mashups and the scripts are stored in ﬁles), you will
also copy the extensions to the new MashZone NextGen installation.

Set Up the MashZone NextGen Repository
Set Up Repository When Using the Embedded Derby Database
If you used the embedded Derby database for your old repository, follow the
instructions below.
1. The new MashZone NextGen comes with a pre-populated Derby repository. Go
to the new_Software AG_directory /MashZoneNG/apache-tomcat/bin and rename
the mashzonenextgenrepository directory (for example, rename the directory
mashzonenextgenrepository_orig).
2. 3.7, 3.8, 3.9, or 9.9 upgrade: Go to the old_Software AG_directory /Presto/apachetomee-jaxrs/bin directory and copy the prestorepository and mashzonerepository
directories to the new_Software AG_directory /MashZoneNG/apache-tomcat/bin
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directory. Rename the prestorepository directory to mashzonenextgenrepository in
the new installation.
3. 9.10 and higher upgrade: Go to the old_Software AG_directory /MashZoneNG/
apache-tomee-jaxrs/bin directory and copy the mashzonenextgenrepository and
mashzonerepository directories to the new_Software AG_directory /MashZoneNG/
apache-tomcat/bin directory.
4. 3.6 upgrade: Go to the old_Software AG_directory /Presto/prestorepository/derby
directory and copy the prestorepository directory to the new_Software AG_directory /
MashZoneNG/apache-tomcat/bin directory. Rename the prestorepository directory
to mashzonenextgenrepository in the new installation.
5. Execute Derby database update SQL commands for 10.1. You can execute these
commands using any SQL client that can connect to Derby, or you can use the Derby
IJ utility delivered with MashZone NextGen, as follows:
a. Open a command window and change to the directory where the Derby
database resides (for example, cd new_Software AG_directory /MashZoneNG/
apache-tomcat/bin).
b. Start the IJ utility by running this command:
java -jar SAG_HOME/MashZoneNG/prestorepository/derby/lib/derbyrun.jar ij

c. Connect to the embedded Derby database by running this command:
connect 'jdbc:derby:mashzonenextgenrepository';

d. Run the ﬁle using the RUN command. For example:
RUN 'new_Software AG_directory /MashZoneNG/upgrade/10.1/MIGRATE-quartz2-DERBY.sql'

e. Exit the IJ utility by running the command EXIT;

Set Up Repository When Using Any Other Database
If you used MySQL, Oracle, PostGres, or SQL Server for your old repository, follow the
instructions below.
1. Go to the old_Software AG_directory /{Presto|MashZoneNG}/apache-tomee-jaxrs/lib
directory and copy the JDBC driver jar ﬁle for your database to the new_Software
AG_directory /MashZoneNG/apache-tomcat/lib directory.
Database

JDBC Driver Jar File

MySQL

mysql-connector-java-5.1.31.jar

Oracle

ojdbc6.jar

PostGres

postgresql-9.2.1004.jdbc4.jar

SQL Server

jtds-1.3.1.jar
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2. If you used MySQL, Oracle, or SQL Server for the old product, do the following:
a. Go to the new_Software AG_directory /{Presto|MashZoneNG}/apache-tomcat/
webapps/mashzone/WEB-INF/lib directory and delete the jackbe-presto-rdspostgre-derby-10.1.jar ﬁle.
b. Go to the new_Software AG_directory /{Presto|MashZoneNG}/prestorepository
directory and copy the jackbe-presto-rds-oracle-mysql-mssql-10.1.jar ﬁle to the
new_Software AG_directory /MashZoneNG/apache-tomcat/webapps/mashzone/
WEB-INF/lib directory.
3. Conﬁgure the new MashZone NextGen to use the existing repository. For
instructions, see MashZone NextGen Administration Guide, and then see the section
on geing started with MashZone NextGen, and then see the section on moving the
MashZone NextGen repositories to a robust database solution. Skip steps 1 through
4, and start with step 5.
Note:

In MashZone NextGen 10.0 and earlier, repository connection information
was deﬁned in the apache-tomee-jaxrs/conf/tomee.xml ﬁle. In MashZone
NextGen 10.1, repository connection information was moved to the
apache-tomcat/conf/context.xml ﬁle and the format has changed.

4. Execute database update SQL commands for 10.1. Use a SQL client that is connected
to your mashzonenextgenrepository. If you need help, contact Software AG Global
Support.
a. Go to the new_SoftwareAG_directory /MashZoneNG/upgrade/10.1 directory and
open the appropriate database_type .xml ﬁle in a text editor.
b. Read the instructions in the ﬁle and modify SQL statements that remove existing
constraints as necessary.
c. Execute the SQL statements in the ﬁle one by one.

9.10 Upgrade: Add Data from Old Repository to New Repository
MashZone NextGen 9.10 had two repositories, mashzonerepository and
mashzonenextgenrepository. Starting with MashZone NextGen 9.12, there is only one
repository, mashzonenextgenrepository. The new mashzonenextgenrepository already
contains the data from the old mashzonenextgenrepository, but you must manually add
the data from the old mashzonerepository.
1. Go to the new_Software AG_directory /MashZoneNG/apache-tomcat/conf directory
and open the context.xml ﬁle. Add a <Resource> entry that sets the connection
aributes properly for the old mashzonerepository. For example:
<Resource name="amzDatabase" auth="Container" type="javax.sql.DataSource"
maxTotal="200"
maxIdle="30"
maxWaitMillis="10000"
validationQuery="values(1)"
username="app"
password="app"
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driverClassName="org.apache.derby.jdbc.EmbeddedDriver"
url="jdbc:derby:
${catalina.base}/bin/mashzonenrepository"/>

2. Go to the new_Software AG_directory /MashZoneNG/apache-tomcat/webapps/
mashzone/WEB-INF directory, open the web.xml ﬁle in a text editor, and add this
XML <resource-ref> element to the boom of the ﬁle, just before the closing </
web-app> tag:
<resource-ref>
<description>DB Connection</description>
<res-ref-name>amzDatabase</res-ref-name>
<res-type>javax.sql.DataSource</res-type>
<res-auth>Container</res-auth>
</resource-ref>

3. Start the MashZone NextGen server.
Data from the amzDatabase will automatically be migrated into the
mashzonenextgenrepository, and amzDatabase will no longer be used.
4. Shut down the server.
5. Go to the new_Software AG_directory /MashZoneNG/apache-tomcat/webapps/
mashzone/WEB-INF directory and open the web.xml ﬁle in a text editor. Remove the
<resource-ref> element you just added and save the ﬁle.
6. Go to the new_Software AG_directory /MashZoneNG/apache-tomcat/conf directory
and open the context.xml ﬁle. Remove the <Resource id="amzDatabase"> element
and save the ﬁle.

Update the MashZone NextGen Configuration and Copy Extensions
Most of the MashZone NextGen conﬁguration is stored in the MashZone NextGen
repository. This section explains how to copy the parts of the old conﬁguration that were
not maintained in the repository, including extensions such as custom security proﬁles
that you deployed in the old product. The procedure varies depending on whether you
used an external conﬁguration directory with the old product.

Update When an External Configuration Directory Was Used
1. Update the classpath in the application server that hosts the new MashZone
NextGen to work with the external conﬁguration directory and any subdirectories.
For instructions, see the topic on seing up an external conﬁguration directory in the
MashZone NextGen Administration Guide.
2. Manually migrate the changes you made in the old conﬁguration ﬁles listed below
from the old product to the corresponding ﬁles in the new MashZone NextGen.
Because of the complexity of the conﬁguration, the easiest method is to use the
diﬀerence tool oﬀered by many text editors.
All ﬁles listed in the topic on conﬁguration ﬁles that must be internal in
MashZone NextGen Administration Guide.
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The userRepositoryLdap.properties ﬁle, located in the external conﬁguration
directory.

Update When No External Configuration Directory Was Used
1. Copy any extensions you deployed from the old product to the corresponding
directory for the new MashZone NextGen. See the MashZone NextGen Administration
Guide for a complete list of extensions you might need to copy.
2. Manually migrate the changes you made in the old conﬁguration ﬁles listed below
from the old product to the corresponding ﬁles in the new MashZone NextGen.
Because of the complexity of the conﬁguration, the easiest method is to use the
diﬀerence tool oﬀered by many text editors.
All ﬁles listed in the section on conﬁguration ﬁles that must be internal in
MashZone NextGen Administration Guide.
The userRepositoryLdap.properties ﬁle, located in the old_Software AG_directory /
{Presto|MashZoneNG}/apache-tomee-jaxrs/webapps/mashzone/WEB-INF/
classes directory.

Run Upgrade Commands
3.7 or 3.8 Upgrade: Copy Integrated MashZone Data and Run Upgrade
Commands
MashZone NextGen’s Integrated MashZone Server stores additional data. Copy the data
to the newMashZone NextGen installation as follows:
1. Go to the old_Software AG_directory /Presto/mashzone/data/resources directory and
copy the ﬁles to the new_Software AG_directory /MashZoneNG/mashzone/data/
resources directory.
2. Go to the old_Software AG_directory /Presto/mashzone/data/jdbcdrivers directory
and copy the ﬁles to the new_Software AG_directory /MashZoneNG/mashzone/data/
jdbcdrivers directory.
3. Start the MashZone NextGen server. Open a command window or shell, go to the
new_Software AG_directory /MashZoneNG/prestocli/bin directory, and run these
commands:
./padmin.bat runRequestFile -u Administrator -c -w manage
-f ../../upgrade/3.9/upgrade_3.9.0.jump.txt
./padmin.bat importPolicy -u Administrator -w manage
-f ../../upgrade/3.9/Presto_RO_Policy.xml

4. Go to the Admin Console in MashZone NextGen Hub. Expand the MashZone
section, click Server Settings, and click the Resources tab. Review the paths to resource
directories. If any paths point to directories in the old installation, copy those
directories to the new MashZone NextGen installation and then update the paths
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in MashZone Administration to point to the correct location in the new MashZone
NextGen installation.

3.9 Upgrade: Copy Integrated MashZone Data and Run Upgrade Commands
1. If you used the Integrated MashZone Feed Editor in Presto 3.9, and you uploaded
ﬁles or JDBC drivers for use in the Feed Editor, you must copy the ﬁles and drivers
to the new MashZone NextGen installation.
a. Go to the old_Software AG_directory /Presto/mashzone/data/resources directory
and copy the ﬁles to the new_Software AG_directory /MashZoneNG/mashzone/
data/resources directory.
b. Go to the old_Software AG_directory /Presto/mashzone/data/jdbcdrivers directory
and copy the ﬁles to the new_Software AG_directory /MashZoneNG/mashzone/
data/jdbcdrivers directory.
c. Start the new MashZone NextGen server and go to the Admin Console in
MashZone NextGen Hub. Expand the File Resources section and click the File
Resources link. If any paths point to resource directories in the old installation,
copy those directories to the new installation and then update the paths to point
to the copied directories.
2. Open a browser and enter the URL server-IP_address:port/mashzone/hub/
dev/.
3. Log on as administrator. The default user name and password are Administrator
\manage.
4. Go to the API Console.
5. Under the Pick an API frame in the left navigation area, expand PolicyService then
select reloadPermissionSets.
6. Click Run in the upper right corner. MashZone NextGen executes the
reloadPermissionSets API call, which populates the Request frame.
7. Copy RAQL user-deﬁned functions deployed in Presto 3.9 to the new MashZone
NextGen. Go to the old_Software AG_directory /Presto/raql-udfs directory and
recursively copy all ﬁles other than the SampleRaqlLib ﬁle to the new_Software
AG_directory /MashZoneNG/raql-udfs directory.
8. Upgrade the JDBC conﬁguration. For instructions, see the MashZone NextGen User
and Developer Guide.

9.9 Upgrade: Upgrade JDBC Configuration and Run Upgrade Commands
1. Upgrade the JDBC conﬁguration. For instructions, see the MashZone NextGen User
and Developer Guide.
2. Start the MashZone NextGen server.
3. Open a command window or shell, go to the new_Software AG_directory /
MashZoneNG/prestocli/bin directory, and run this command:
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./padmin.bat importPolicy -u Administrator -w manage
-f ../../upgrade/9.10/PrestoFilesPolicy.xml
./padmin.bat runRequestFile -u Administrator -c -w manage
-f ../../upgrade/9.10/upgrade_9.10.0.jump.txt

9.10 Upgrade: Migrate Feeds and Run Upgrade Commands
1. Data feeds that were created with the 9.10 MashZone Feed Editor are not supported
in MashZone NextGen 9.12 and later. If you want to use these data feeds you must
export them from the old release and then import them into MashZone NextGen
10.1. For instructions on exporting and importing data feeds, see the MashZone
NextGen Administration Guide.
2. If the MashZone NextGen server is not running, start it.
3. Open a command window or shell, go to the new_Software AG_directory /
MashZoneNG/prestocli/bin directory, and run this command:
./padmin.bat runRequestFile -u Administrator -c -w manage
-f ../../upgrade/9.12/upgrade_9.12.0.jump.txt"

3.6 or 3.7 Upgrade: Update Mashups that Use RAQL Queries
Presto 3.8 and later contain signiﬁcant changes and additions to the RAQL query syntax
that you use in mashups. If you have mashups from Presto 3.7 or earlier, you must
update the mashups that use RAQL queries to run on the new MashZone NextGen,
but you might want to also update the other mashups to take advantage of new RAQL
query syntax. For complete information, see the topic about migrating old RAQL queries
to the new release in the MashZone NextGen User and Developer Guide.

Update the Snapshots Repository Connection Information
If you used Snapshots in the old product and you stored the data in a separate
Snapshots repository, follow the steps below.
1. If the MashZone NextGen server is not already running, start the server.
2. Log on as Administrator and go to the Admin Console.
3. If the JDBC driver you used with the old Snapshots repository is not the same driver
you used for the old repository, go to the old_Software AG_directory /Presto/apachetomee-jaxrs/lib directory. Copy the JDBC driver jar ﬁle for the database that contains
the Snapshots repository over the same ﬁle in the new_Software AG_directory /
MashZone/apache-tomcat/lib directory.
Database

JDBC Driver Jar File

Derby

derby-embedded-10.5.3.jar

MySQL

mysql-connector-java-5.1.31.jar
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Database

JDBC Driver Jar File

Oracle

ojdbc6.jar

PostGres

postgresql-9.2.1004.jdbc4.jar

SQL
Server

jtds-1.3.1.jar

4. Update the new Snapshots conﬁguration to point to the new Snapshots repository as
follows:
a. Open the JDBC Configuration menu, click Datasources, click SnapshotDatasource,
and then click Edit.
b. Edit the conﬁguration properties as needed. For information on the properties,
see the section on adding a data source in the MashZone NextGen Administration
Guide.
c. Click Save.

Migrate MashZone NextGen Explorer
Migrate Data and Configurations
1. MashZone NextGen Explorer stores its data, including data source descriptions
of deployed data sources, analyses, and projects, in its registry in the
SoftwareAG_directory /MashZoneNG/VisualAnalytics/data directory. The ﬁles used to
deploy data sources and the corresponding .vsd data source description ﬁles created
by MashZone NextGen Explorer are also stored in that directory. To migrate both,
copy the old_SoftwareAG_directory /MashZoneNG/VisualAnalytics/data directory
over the same directory in the new installation.
2. If you are migrating data from one MashZone NextGen Explorer 10.1 to another (for
example, for a data center move), copy the old_SoftwareAG_directory /MashZoneNG/
VisualAnalytics/conﬁg directory over the same directory in the new installation.
Then modify the copied conﬁguration as necessary.
3. Migrate data for the embedded Spark by copying the old_SoftwareAG_directory /
MashZoneNG/VisualAnalytics/va-sjs/conﬁg directory over the same directory in the
new installation.
4. If you are migrating data from one MashZone NextGen Explorer 10.1 to another,
migrate the data for the embedded Kaa as follows:
a. Go to the old_SoftwareAG_directory /MashZoneNG/VisualAnalytics/va-kaa
directory.
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b. Copy the data directory over the same directory in the new installation.
c. Copy the conﬁg directory over the same directory in the new installation.
d. Modify the copied conﬁgurations as necessary.

Update Analyses
MashZone NextGen Explorer 10.1 introduces many new visualization and analysis
features. If you are migrating from MashZone NextGen Visual Analytics 9.12 or 10.0,
some analyses might require an update.
1. Start MashZone NextGen Explorer.
2. Open the Analyses View in the Explorer module.
3. Click each analysis and compare the preview image with the presented visualization.
If the original analysis partitioned the data, drag the columns from the Columns area
to the Partition area of the Data Columns bar at the right-hand side of the view. If the
chart type does not ﬁt the original chart type or a trendline is gone, reconﬁgure the
visualization options of the analysis.
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Read and Complete All Previous Chapters
Before performing any task in this chapter, read all chapters that precede this chapter
carefully and complete all tasks that apply to your products in the order in which they
are presented in those chapters.

9.7, 9.8, or 9.9 Upgrade: Migrate Mobile Designer
If you created apps using the Mobile Development perspective in Software AG Designer
and want to continue to do so, or if you created apps using Mobile Designer but want to
use the Mobile Development perspective in Software AG Designer from now on, delete
the environment variable MOBILE_DESIGNER as instructed below.
If you created apps using Mobile Designer and want to continue to do so,
and if you also want to continue to use your existing build environment
(that is, an IDE other than Software AG Designer, or Jenkins), delete the
MOBILE_DESIGNER environment variable as instructed below. Then pass the property
#Denv.MOBILE_DESIGNER=full_path_to_Mobile Designer to Ant when calling
Mobile Designer Ant targets (for example, enter ant #Denv.MOBILE_DESIGNER=C:
\SoftwareAG\MobileDesigner +Multi-Build).
To remove the MOBILE_DESIGNER environment variable, do the following:
System

Steps

Windows

Go to the Control Panel, click System, and then clickAdvanced System
Settings. On the Advanced tab, click Environment Variables and delete
the MOBILE_DESIGNER environment variable. Then restart your
system.

Mac OS
X

Delete the MOBILE_DESIGNER environment variable from
your .bash_proﬁle, your \etc\launchd.conf ﬁle, or both. The ﬁle or
ﬁles that contain the environment variable depend on the version
of MAC OS X you are using, and on modiﬁcations you might have
made. Then restart your system.

Migrate Mobile Administrator
Overview
You will complete the Mobile Administrator upgrade by:

Upgrading Software AG Products Version 10.1

118

M

Odd Header
Migrate the Mobile Suite

Running the Mobile Administrator updater to upgrade the Mobile Administrator
source code and migrate the Mobile Administrator database.
Verifying that all features required by your use case are conﬁgured.
Updating any build nodes you used with the old Mobile Administrator.
Updating the App Store Client.

Run the Updater and Verify Configurations
1. Go to the Software AG_directory \MobileAdministrator directory and run the updater
by running the command .\update.sh as root.
2. From the same directory, start Mobile Administrator by running the command \etc
\init.d\appfresh-mobile start.
3. In Mobile Administrator, click Settings, click Sites, and click a domain. On the
domain page, click Configuration Assistant. Make sure all the features you need are
conﬁgured. If necessary, follow the instructions to conﬁgure any features that are
missing. Repeat this step for each domain.

Update Build Nodes
1. If you used the Mac OS build node with the old Mobile Administrator, update the
build node as follows:
a. Go to the Mobile Administrator > Build Nodes page at hps://Mobile
Administrator_URL /build_nodes. Download the appfresh-build-node-version .zip
ﬁle, and extract the ﬁles to any directory.
b. Launch the build node application. On the Install tab, in the Build Node ﬁeld, make
sure the displayed build node version corresponds to the version of the build
node you just downloaded (that is, appfresh-build-node-version .zip).
2. If you used the Windows 8 build node with the old Mobile Administrator, update
the build node as follows:
a. Go to the Windows Control Panel and uninstall the previous build node.
b. Go to the Mobile Administrator > Build Nodes page at hps:/Mobile
Administrator_URL /build_nodes. Download and run the
AppFreshBuildNode-version .exe ﬁle.
c. Launch the build node application. On the Build Node tab, start the build node by
clicking Start.

Update the App Store Client
1. Go to the hps:/Mobile Administrator_URL /apps/appfresh-mobile-client/build page.
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2. On the Build Configurations tab, start the build jobs for the App Store Client by
selecting the platforms for which to update the client and clicking Launch Selected
Build Configs.
3. On the Build Jobs tab, verify that the build jobs have completed successfully.
Corresponding build nodes should appear on the hps:/Mobile Administrator_URL /
build_nodes page. If they do not, click on the build job to display the details that will
help you diagnose the problem.
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Read and Complete All Previous Chapters
Before performing any task in this chapter, read all chapters that precede this chapter
carefully and complete all tasks that apply to your products in the order in which they
are presented in those chapters.

Before Migrating
If the new and old OneDatas are on the same machine, make sure the old OneData is
shut down.

Run the OneData Migration Utility
The OneData migration utility migrates conﬁguration data.
The OneData migration utility runs without prompting you for any information. If an
error occurs, the utility exits.
For a general description of migration utility behavior, see "Migration Utilities" on page
42.
On the machine that hosts the new OneData, open a command window or shell, go
to the new_Software AG_directory /proﬁles/ODE/bin/migrate directory, and run the
command below.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory|ZIP_file}
-silent true

Before migrating data, the utility backs up the ﬁles that contain the new conﬁguration
data in the new_Software AG_directory /proﬁles/ODE/bin/onedata/conﬁg directory. The
backup ﬁles have the extension .bck.

Complete the OneData Upgrade
1. If you customized the old OneData Java Service Wrapper, copy the customizations
from the old custom_wrapper.conf ﬁles to the new custom_wrapper.conf ﬁle. The
ﬁles are located in the Software AG_directory /proﬁles/ODE/conﬁguration directory.
Note:

As noted in the Software AG Infrastructure Administrator's Guide, you
should never modify the wrapper.conf ﬁle unless instructed to do so
by Software AG. If you mistakenly modiﬁed the old wrapper.conf ﬁle,
manually copy values for properties you modiﬁed in the old wrapper.conf
ﬁle to the corresponding properties in the new custom_wrapper.conf ﬁle.

Upgrading Software AG Products Version 10.1

122

M

Odd Header
Migrate OneData

2. If you are using JMS with OneData, copy the client jar ﬁles you backed up earlier
to the new_Software AG_directory /proﬁles/ODE/webapp/onedata/WEB-INF/lib
directory.
3. If you are using Kerberos authentication with OneData, reconﬁgure it using
the backups of the web.xml, server.xml, jaas.conﬁg, custom_wrapper.conf and
com.softwareag.jaas.realm.pid-SSO_realm_name .properties ﬁles you created earlier.
For instructions, see Administering webMethods OneData.
4. Go to the new_Software AG_directory /proﬁles/ODE/conﬁguration/
com.softwareag.platform.conﬁg.propsloader directory. Open the three
com.softwareag.catalina.resource.pid-onedataschema Db1.properties ﬁles, where
schema is md, wa, or ra. Replace values for database parameters such as maxIdle,
maxActive and maxWait with the values you noted earlier from the old installation.
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Migrate Software AG Digital Event Services
Digital Event Services components are automatically installed with products, except for
Microservices Container. These components are the Digital Event Services runtime and
the Digital Event Services Type Repository.

Before Migrating
Make sure none of the new products are running.

Run the Software AG Digital Event Services Migration Utility
The Digital Event Services migration utility migrates the following:
Digital Event Services runtime conﬁgurations for all products.
Digital Event Services Type Repository.
10.0 upgrade: Digital Event Services passwords.
The Software AG Digital Event Services migration utility runs without prompting you
for any information. If an error occurs, the utility exits.
For a general description of migration utility behavior, see "Migration Utilities" on page
42.
On the machine that hosts the new products, open a command window or shell, go to
the new_Software AG_directory /common/migrate/DigitalEventServices/bin directory,
and run the command below. For the migrateold_release sbs.dat ﬁle, specify old_release
without periods (for example, 9120).
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software
AG_directory|ZIP_file}
-importFile migrateold_release sbs.dat
-silent true

Migrate Software AG Event Routing
Event Routing components are automatically installed with products. These components
are Event Type Store, Digital Event Persistence, and Event Routing.

Before Migrating
Make sure none of the new products are running.
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Run the Software AG Event Routing Migration Utility
The Software AG Event Routing migration utility migrates the following:
Event Type Store.
9.9 and higher upgrade: Event Routing conﬁgurations for all products.
The Software AG Event Routing migration utility runs without prompting you for any
information. If an error occurs, the utility exits.
For a general description of migration utility behavior, see "Migration Utilities" on page
42.
On the machine that hosts the new products, open a command window or shell, go
to the new_Software AG_directory /common/migrate/EDA/bin directory, and run the
command below. For the migrateold_release sbs.dat ﬁle, specify old_release without
periods (for example, 980, or 9100).
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software
AG_directory|ZIP_file}
-importFile migrateold_release sbs.dat
-silent true

Migrate Undelivered Events
Go to the new_Software AG_directory /install/log directory and open the migrationLog.txt
ﬁle. If you see the message below for one or more products, events that were delivered
to those products in the old installation were not acknowledged before the products
were shut down.
WARNING: There are still
These events will not be
Event Routing in the new
events manually, see the

events left in IP storage location_of_old_storage_file .
migrated automatically and will not be redelivered by
installation. For information how to migrate these
upgrade guide.

To enable Event Routing to deliver the events to products in the new installation,
you must copy the old storage ﬁles to the new installation. For each message, do the
following:
If the message provides the full path to the old storage ﬁle, the old storage ﬁle is
in the default location (that is, the new_Software AG_directory /proﬁles/product /
conﬁguration/event/routing/runtime/storage directory). Copy the old storage ﬁle to
the same location in the new installation directory.
If the message identiﬁes the old storage ﬁle (for example, c:\EventRoutingStorage
\SomeName_Reliable.mem) but does not provide the full path, the old storage ﬁle is
in a non-default location.
1. In the migrationLog.txt ﬁle, determine to which product the message applies.
2. Go to the new_Software AG_directory /proﬁles/product /conﬁguration/event/
routing/runtime directory.
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3. Open the conﬁguration.json ﬁle and ﬁnd the storage-location property.
4. Copy the old storage ﬁle to the directory speciﬁed on the property.

Migrate Event Persistence Services
If you used Digital Event Persistence to persist events in the old installation, conﬁgure
new services in the new installation.

Complete Final Upgrade Tasks for All Products
Before performing any task in this chapter, read all chapters that precede this
chapter carefully and complete all tasks that apply to your products in the order in
which they are presented in those chapters.
Conﬁgure your new products. For instructions, see the product documentation for
the new release.
If you installed your new products on a diﬀerent machine than your old products,
make sure to update host names in your new products, in the connections between
your products, and in your database tables. This guide indicates many locations
in which to update host names, but make sure you also specify the correct host
names when you conﬁgure your new products using the instructions in the product
documentation. Also make sure any absolute paths in the new conﬁguration ﬁles
point to valid locations, or change them to be correct for the new machine. If the
machine has a diﬀerent operating system or hardware, make sure your JVM seings
are correct.
Read the product readmes for the new release, including the readme for the Software
AG Infrastructure. All readmes are available on the Software AG Documentation
website. The product readmes contain this information:
Critical information and known and resolved issues for your products.
Changes to product behavior, services, parameters, properties, and APIs. Such
changes can include additions, changes, deprecations, and removals. This
information is especially important because you might need to modify product
ﬁles or assets after migration to accommodate the changes.
Read the information in product readmes for your old release+1 through the new
release. For example, if you are upgrading from 9.5 to 10.1, read the information for
releases 9.6 through 10.1.
After installation, you might have set Windows services for products to Manual, and
disabled scripts that start UNIX daemons, to avoid automatically starting both old
and new products. When your new environment is ready, after you stop running the
old products and when you want to start running the new ones, you can reset the
Windows services to Automatic, and re-enable the UNIX scripts.
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After you have thoroughly tested your new environment, you can reclaim disk space
by deleting ZIP ﬁles and ﬁles extracted from ZIP ﬁles from new machines, or by
uninstalling products from old machines. To uninstall old products, you must use
the Software AG Uninstaller for the old release.

Upgrading Software AG Products Version 10.1

129

